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1Getting Started with 
PREMIER+™ 2 Modify
Welcome to PREMIER+™ 2 Modify. Use PREMIER+™ 2 Modify to adjust your embroideries 
to create new ones. Work with sections (subdesigns) of embroideries or whole 
embroideries, and with multipart embroideries or many embroideries at once. PREMIER+™ 
2 Modify contains all the editing facilities of PREMIER+™ 2 Embroidery Extra, with many 
additional powerful features.

Edit stitches directly in 3D or 2D, as desired. Use the Stitch Player in the Control Strip to 
play through the currently selected embroidery subdesign as if it is stitching out, or use 
the Design Player  to play through all sections of an embroidery. Use Life View  to 
view the embroidery in real-world perspective with the desired export options.

Emboss helps you to add beautiful patterns to your embroideries. Choose from over 100 
stamps, or use text or your own design, to make a single stamp, to stamp along a line or to 
fill a large area.

Use point morphing to magnetize, polarize, twirl or ripple stitches in small areas, or the 
eight global morphing effects to change the whole shape of an embroidery. With 
Freehand Tablet Cutwork Line  and Freehand Point Cutwork Line  you may 
automatically remove fabric for cutwork and reverse appliqué, or simply to cut out a shape 
or design.

Use Freehand Tablet Border , Freehand Point Border , Draw Border Shape  or 
Border Embroidery  to make a new embroidery with a satin, running, triple or motif 
border, optionally with appliqué stitches and fabric. Keep the section of embroidery from 
inside or outside the border, or simply overlay the border. As in PREMIER+™ 2 Embroidery 
Extra, the Appliqué Piece functions Express Appliqué , Appliqué Outline  and 
Appliqué Hole  enable you to add appliqué fabric to an existing design with appliqué 
areas, and to adjust appliqué areas within a design.

Apply the Monochrome  effect to create silhouette and cameo designs from 
multicolored embroideries. Use the Density Advisor  to see dense stitch areas and, if 
desired, automatically reduce the density. The Stitch Optimizer  improves the stitchout 
of the embroidery, both in speed and quality. Use Automatically Add Trim Commands  
to trim movement stitches while stitching out, and Basting Line  to secure your fabric 
and stabilizer before stitching. Mark any group of stitches as special Alignment  
stitches, and add Tie On  or Tie Off  stitches as desired.

Add and remove Color Change , Stop  and Trim  Commands. Add customized 
text to Stop commnds to streamline the stitching process. Center Designs , 
Compensate Stitches , Break Up  stitches to your preferred maximum length, and so 
much more.
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Design Separator  allows you to creatively cut any embroidery into two subdesigns. 
(Use the PREMIER+™ 2 Design Aligner  module to automatically split embroideries into 
multiple sections for stitching out in any hoop, or two subdesigns for multipart hoops.)

Use Object Editing to reshape and restyle your embroidery. Change the properties for a 
stitch type in a line, fill or satin area in your embroidery, and even convert an object from 
one stitch type to another. Remove underlay and packing with Remove Underlying 
Stitches .

Sample Files
Samples are included that are shown in the ’How-To’ examples and tutorials.The sample 
files will be installed to subfolders of Documents\Premier+2\Samples\Modify or the folder 
of your choice.

Starting PREMIER+™ 2 Modify
 In PREMIER+™ 2 Embroidery , click the PREMIER+™ 2 Modify icon  on the QuickLink 

toolbar. PREMIER+™ 2 Modify will start.

Parts of the Software Window

Title Bar
The Title Bar at the top of the window is highlighted if 
PREMIER+™ 2 Modify is active. Each open embroidery file 
also has its own tab showing the name of the embroidery file. The Quick Access toolbar 
gives icons for the following frequently used features: Insert, Save, Save As, Export, Print, 
Change Hoop, Undo, Redo, Life View and Design Player. 

Quick Access Toolbar Ribbon Bar Tabs Ribbon Bar

Status BarControl Strip Stitch Area Embroidery Tabs

Design PanelTitle Bar
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Ribbon Bar
There are nine tabs on the ribbon: File, Home, Modify, Border, Appliqué, Emboss, Object, 
View and Help.

Use the Home tab to select subdesigns or stitches, copy, resize, move and rotate, change 
threads with Color Tone, and display embroideries with Life View and Design Player.

Design Select
The Design Select area of the Home tab shows the different subdesigns or sections of a 
multipart design. Select the Next  or Previous  section, change the order by moving 
subdesigns forwards  or backwards , or combine  sections of a multipart 
embroidery.

Use the Modify tab to make changes that affect the whole embroidery, to add and edit 
stitch commands, and to use the morphing and cutwork features.

Use the Border tab to add a satin or stitch border to an embroidery, optionally with 
appliqué stitches and fabric.

Use the Appliqué tab to add appliqué fabric to an existing design with appliqué areas, and 
to adjust appliqué areas within a design.

Use the Emboss tab to add lines or curves of stitch points and to apply stitch points in 
shapes (called stamps) one at a time, in lines or as a fill pattern.

Use the Object tab to change the properties for the fill and line objects in your 
embroidery, or to convert these stitch types to other fill and line types.

Use the View tab to adjust the Grid,  change the view mode, view Commands and stitch 
coordinates, change the hoop, and arrange multiple windows.

Work Area
The work area is the area where embroideries are loaded. There are tabs along the bottom 
edge that show the names of the open embroideries. Click a tab to make it the active 
embroidery. Press Ctrl + Tab to cycle through the windows. When the embroidery file 
windows are maximized then the work area is filled by the active embroidery file. If the 
windows are not maximized, then arrange the windows in various ways using the Cascade 
and Tile options on the View tab, drag the title bars to arrange them as desired, or press 
Ctrl + Tab to cycle through the windows.

Stitch Area
This is the area on which the stitches are drawn and where you make changes to an 
embroidery. Stitches are drawn in the appropriate colors, but most thread effects are not 
shown in the active subdesign. The embroideries are shown in either 3D or 2D, with or 
without stitch points. The background color and texture can be changed using 
PREMIER+™ 2 Configure .

Garment, quilt block or fabric backgrounds may be stored in .vp4 files. They are not shown in PREMIER+™ 2 
Modify, except for any fabric backgrounds used in appliqué. Decorations are shown, but may not be 
edited, except to move or delete the whole subdesign.



4          PREMIER+™ 2 Modify   Getting Started with PREMIER+™ 2 Modify 

In 3D view  the real hoop is shown, with blue corners showing the stitch area within the 
hoop. Movement stitches are hidden. The background texture is shown, if it is selected in 
PREMIER+™ 2 Configure.

In 2D view  with and without stitch points, the hoop size is shown by a blue outline with 
bold corners. Stitches are drawn in plain colors only, and stitches using multicolor threads 
are drawn using only the first color in the thread definition. Movement stitches are shown 
as dotted lines. The background does not use texture in 2D view.

In 2D view with Stitch Points , black dots or small black squares show the stitch points (needle 
insertions) into the fabric. The display of the stitch points, whether they are dots or squares, depends on the 
zoom level. Showing the stitch points may be helpful for inserting new stitches or moving individual 
stitches. The view mode can be set separately in each embroidery. 
Use Ghost Mode  to display pale 'ghost' stitches where there are hidden stitches.

Use Commands  to show or hide the command markers for Color Change , Stop  
Appliqué , and Trim .

Background Grid
Each embroidery has a grid, which may be turned on or off or shown with numbered grid 
lines using the grid options . Zooming in or out makes the grid squares look bigger or 
smaller, but the grid numbers stay the same size. The grid size can be changed from 2mm 
to 50mm using the View tab. The grid and numbering can be turned on and off separately 
in each embroidery window, but changing the grid size affects all windows.

Control Strip
Use the Control Strip to view the colors in the selected section of the embroidery, and to 
select stitches by number, by color block, or with the handles on the slider bar. Stitches 
can be hidden for ease of editing or to protect them from being changed by other 
functions. Also step through the Stop commands in the embroidery.

View how the selected subdesign will be stitched out with the Stitch Player, pausing for 
Color , Stop  and Trim  commands.

Design Panel
To the right of the work area is the Design Panel. Use the Design Panel to change colors, 
and the Notes and Settings.

Design Information
The Design Information shows the dimensions (Height  and Width ), Stitch Count , 
and number of colors  for the active embroidery.

Color Select
The Color Select area shows the order of the color blocks in the color worksheet and any 
notes that are included in the embroidery. Click on a color block to change thread colors, 
and to add thread effects. Also use the color worksheet to show or hide stitches by color 
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block; and move color blocks up  or down  and merge  them. Edit or add 
information to the Notes and Settings as desired.

Clipboard Block and Overview Window
The Clipboard Block shows the embroidery that can be pasted into the work area.

Click in the Clipboard to remove the current Clipboard Block.
The overview window gives a small overview of the whole work area for the current 
embroidery.

Status Bar
The status bar is found at the bottom of the window. Starting from the left, the status bar 
shows:

 The QuickLink toolbar.
 The selection tools.
 The horizontal and vertical distance of the mouse pointer from the center of the 

embroidery.
 The hoop size.
 An indicator of the current function, which is blank when no function is active.
 The zoom tools and Zoom Bar.

PREMIER+™ 2 Modify Terms and Conventions
On-screen pointers
The mouse pointer is most commonly shown as an arrow  on the screen.

The Box Select pointer , Freehand Select pointer  or Freehand Point Select 
pointer  appears when the associated Select function is chosen. Add to a selection with 
the  Add to Selection  pointer, and remove items from a selection with the Remove 
from Selection  pointer.

The Insert Color Command pointer  which places a Color Change , the Insert Stop 
Command pointer  which places a Stop Command , the Insert Trim Command 
pointer  which places a Trim Command , and Insert Stitches pointer  appear 
when the associated Modify Stitch function is chosen. When Tie On or Tie Off are used, the 
tie pointer  appears.

If the Freehand Tablet functions are used the pointer becomes a pen . If the Freehand 
Point functions are chosen, the pointer becomes a circle . When nodes placed by either 
of the Freehand functions are adjusted, the pointer becomes a small cross  (a move 
pointer). The Freehand pointers are also used when drawing a split line for Design 
Separator .

In the Object tab, the Object Select  pointer is shown. Insert points in an object with 
the Insert Point  pointer, and Delete Points with the delete points pointer .

When using stamps, the pointer is the currently selected stamp.

The Measure pointer  appears when the Get Length  function is selected.

The pointer becomes the pink Fabric handle  when adjusting appliqué fabric pieces.
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2Viewing Embroideries & Threads

Design Select
Use the Design Select area of the Home tab to 
view the different sections or subdesigns of a 
multipart design. The selected section is 
displayed in the work area. To move 
subdesigns within the multipart design, see 
“Select, Move and Merge Designs” on page 35.

Standard embroidery subdesigns are numbered. Decoration subdesigns are labeled with 
the letter "D", and Alignment subdesigns are labeled with the letter "A".

Automatic Ghost Mode is used to show the position of the other parts of the design in the work area.

 Click Next Design  or press the Tab key to see the next subdesign.
 Click Previous Design  or press the Tab key to see the previous subdesign.
 Click the desired section of the design in the Design Select area.

To see all subdesigns, click the arrow at the bottom right of the Design Select area.

View Mode
Use View Mode in the View tab to toggle between 3D View , 2D View with Stitch 
Points , and 2D View without Stitch Points   for the current window. Stitches and 
blocks can be edited in both 3D and 2D stitch display.  

Use 2D View without Stitch Points to see the stitch lines, use 2D View with Stitch Points to 
see stitch points clearly, and use 3D View to see how the embroidery will be stitched.

Show and adjust the grid View command markers

Change the view mode Select a different hoop

View the Design Panel

Set grid size
Measure the design View the coordinates of stitch points View multiple designs

3D View 2D View with Stitch Points 2D View without Stitch Points 
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Ghost Mode
Use Ghost Mode  to display pale 'ghost' stitches where there are hidden stitches within 
the active subdesign. This allows you to see the overall embroidery and the placement of 
the visible stitches within the embroidery while working only with the visible stitches.

If the background is white or very pale it may be difficult to see the ’ghost’ stitches.

Background Grid
Use the grid options to turn the background grid on and off, optionally with numbered 
grid lines. The grid may be used to help align stitches, adjust selected blocks, draw border 
shapes precisely and so on. 

Ghost Mode Off Ghost Mode On

Grid On Grid Numbered Half

Use Grid On  to show the grid. Use Grid Numbered Half  to show the grid with 
the even grid lines numbered on the top and left.

Grid Numbered Full Grid Off

Use Grid Numbered Full  to show the grid 
with the even grid lines numbered on all sides.

Use Grid Off  to hide the grid.
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Grid Size
Set the grid size between 2mm and 50mm, depending on what setting is most suitable for 
your screen resolution and embroideries.

Commands
Use Commands  to show or hide the command markers for Color Change , Stop , 
Appliqué  and Trim .

Design Panel
Use the Design Panel to change colors, to view and change the Notes and Settings, and to 
view the Clipboard and Overview window.

To open the Design Panel, click Show Design Panel in the View tab.

Thread Colors
The thread colors are shown in the color worksheet on the Design Panel, in the order in 
which they are used. Any thread effects or special needles used with a color are also 
indicated.

Check the design information

Change a thread color

Edit, move and merge the colors

View the contents of the Clipboard

Edit the Notes or Settings information
Select the Notes or Settings information

View the position in the work area when zoomed in

Dual Thread effect

Puffy Foam effect
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Colors can be added or changed using any color available in the standard thread ranges 
and MyThreads. MyThreads can contain threads copied from the standard thread ranges, 
plus custom threads based on existing threads or added as completely new threads.

A Color Change command  is shown in the embroidery by a small blue circle with a C.

To add a color change, use Insert Color Command . See “Insert Color Command” on page 18.

Move and Merge Color Blocks
Use the arrows below the color worksheet, or the right-click context menu, to change the 
order of the color blocks, and to choose color blocks to merge together selectively. 

For example, you can keep two adjacent identical color blocks in case you wish to vary them later. If you 
use ColorSort, all identical colors will be merged unless there are overlapping stitches, or one block has a 
thread effect.
The changes you make are applied immediately.

This may be useful if you want to merge two blocks of an identical thread color without affecting the color 
order of the rest of the embroidery. Alternatively, the Move and Merge Color Blocks functions may be useful 
if ColorSort does not merge colors owing to a few overlapping stitches that do not affect the design 
stitchout.
You can also use Merge when optimizing designs with multiple areas of cutwork and stabilizing lines. 
ColorSort may occasionally merge stabilizing lines in these circumstances. 

ColorSort
Use ColorSort  to reduce the embroidery to the minimum number of color blocks. The 
final number of color blocks produced in the ColorSort process can vary, depending on 
any overlap between areas, or whether thread effects are used. If possible, it leaves only 
one color block for each thread color used.

Alternatively, you can use the ColorSort option in Export  to merge your color blocks when creating an 
embroidery file for stitching out. 
ColorSort affects the whole of the embroidery, even if only part of it is visible. All stitches 
in the embroidery will be shown when the ColorSort is complete.

Monochrome
Use Monochrome  to change all visible stitches to one color. The Monochrome effect 
creates silhouette and cameo designs from multicolored embroideries

Select the stitches that you want to set to the same color, then click Monochrome . The 
Color Selection dialog appears so you can choose a color and/or thread effect.

Pause over a thread color
to see its name

Merge with color above

Click a color to select it

Move color up the stitch order

Display or hide a color

Change the selected color
Move color down the stitch order

Thread effect symbol
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Control Strip
Use the Control Strip to view the colors in the selected subdesign, and to select stitches 
using the handles on the slider bar.

For precise positioning, enter numbers in the start and end boxes, or select stitches within 
the next  or previous  color block, or move to the next  or previous  Stop  
command. Use Invert Visible Color Blocks  to switch the visibility of the color blocks so 
that those that were visible become hidden, and those that were hidden are displayed. 
View the whole embroidery with Draw All Stitches , or see an outline of the hidden 
stitches with Ghost Mode .

Use the Stitch Player to view how the selected subdesign will be stitched out, using Pause 
for Commands  to view where Color , Stop  and Trim  commands will be 
placed.

Use Design Player  to view how the complete project will be stitched out, using the Optimize for Sewing 
settings from PREMIER+™ 2 Configure. See “Design Player” on page 11.

View a Range of Stitches
The draw Start and End slider bars in the Control Strip provide a very powerful way of 
viewing an embroidery and understanding exactly how it is formed. They allow you to 
progress forwards and/or backwards through an embroidery stitch by stitch and isolate a 
specific sequence of stitches. If desired, select the visible stitches as a block to work on 
(Select All Visible ) or use a feature such as stamping or global morphing without 
affecting the hidden stitches. If desired, use Ghost Mode  to show the overall shape of 
the embroidery while only working on visible stitches. Changing the range of stitches can 
be combined with selecting colors to display a particular set of stitches that would be 
difficult to isolate with other functions.

Draw Range (Slider Bar)
The left handle and left stitch number box set the Draw From Start stitch number. The 
right handle and right stitch number box set the Draw To End stitch number. 

Use the Draw Range to set the Start or End stitch number in any of the following ways, as 
shown here for Draw From Start:

Draw all stitches 

Ghost Mode: see an outline of hidden stitches

Switch the visibility of color blocks
Show only the previous/next color

Draw stitches to here

Play through the visible stitches

View where commands are placedDraw stitches from here

Set numbers for the
start and end stitches Show the previous/next Stop command
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1 Click and drag the handle along the slider bar. The stitch 
number will change as you move the handle.

2 Click the arrows at the end of the number boxes to change 
the stitch number by one at a time. Click and hold on an 
arrow to progress more rapidly.

3 Click in the space on the slider bar on either side of the 
handle to move it in that direction and change the stitch 
number by 50 at a time. You can also click and hold to 
change the number more rapidly, but the handle will stop 
when it reaches the arrow pointer, or the other handle.

4 Enter a stitch number directly in the stitch number box. A 
number that is outside the range will be ignored.

In all cases, the work area will show the range of stitches as the Start or End number changes.

Get Length
Use Get Length  to measure the distance between any two points on an embroidery. 
Click the Get Length icon  and the mouse pointer changes to the Measure pointer . 

Coordinates
Use Coordinates  to show and hide the Stitch Coordinates dialog box, which shows the 
coordinates of stitch points. This can also be used to change stitch point positions by 
editing x and y coordinates.

Design Player

Use Design Player to play through the stitches in the embroidery as if they were being 
stitched from an exported embroidery. All parts of the embroidery that are within the 
hoop area are shown, whether or not they are selected.

The current Optimize for Sewing settings from PREMIER+™ 2 Configure are used.

Start or pause play

Control play with
the slider

Design Information

Jump to the first stitch

Jump to the last stitch

Rewind

Play at double the
current speed
Share a picture or video 
online
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All the designs in a multipart embroidery are shown in the Design Player. This is therefore a good way to 
see the whole project after adjusting stitches in one of the designs.

 Any messages, for example instructions for appliqué placement, are displayed following 
their Stop commands.

 Appliqué fabric is displayed if present, but any background garment, quilt block or fabric 
is not shown.

 Decorations are shown following their placement stitches.

Embroideries that are outside the hoop are not shown in the Design Player. If an 
embroidery contains a felting needle, the project will be shown "flipped", as it would 
actually be stitched.

Life View
Use Life View  to show how an embroidery exported from the project will look in 3D 
with real-world perspective. Zoom in to see detail, and move and rotate the embroidery in 
a three-dimensional view. All parts of the embroidery that are within the hoop area are 
shown, whether or not they are selected. 

Use Life View  at any time when you want to see the design with no grid, stitches 
selected, or markers displayed, and when you want to see the effects of glow in the dark 
and solar reactive threads.

 Any background garment, quilt block or fabric is shown, together with appliqué fabric, if 
present.

 Decorations are shown, but not their placement stitches.

Design Information

Move around the window

Change the 3D viewing angle

Zoom in and out

Light and dark effects
Reset
Animate the preview
Share a picture or video online
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3Select Stitches and Blocks

When viewing stitches, it is often helpful to select 2D. To see the stitch points, select 2D 
View with Stitch Points  so the stitch points are visible for selecting and moving them.

Zoom in close enough to see the separate stitch points. 
Color Change , Stop  and Trim  command markers and their associated stitch 
points can be moved, but they can only be deleted using Delete Commands . 

The command markers are enlarged when one of the Modify Stitch functions in the Modify tab is selected. 
See “Modify Stitch” on page 18.

Select Stitches
Use Select Stitches  to select and edit single stitches. Simply 
click a stitch point and a box appears around the point to show 
that it is selected.

Click and drag the box to move the stitch point. If desired, use 
Delete  to delete the stitch point.

Select a Series of Stitches
Click the first required stitch point, then hold down Shift (on the keyboard) and click the 
last required stitch point. The two stitches you click and all stitches between them will be 
selected. Click outside the block to make a new selection using this method.

To select several individual stitches, hold down Ctrl and click the desired stitches.

Alternatively, hold down Shift and use the left and right arrow keys to select a series of stitches.

Select a Block of Stitches
The block Select functions in the Select area of the Home tab allow you to select part of an 
embroidery. A selected part of an embroidery is called a block. A block can be resized/
scaled, rotated, mirrored, skewed, moved, nudged, duplicated, copied, cut and deleted.

When a block has been selected, it has a selection box around it on the work area. The 
selection box has handles which are used to resize, rotate, skew and flip the block. Also, 
the block is outlined within the selection box, to assist with accurate positioning when it is 
moved or rotated.

You may find it easier to select a block when you have selected colors to display and/or changed the ranges 
of stitches that are visible.

Select a design

Move and merge the designs
View the embroidery as it will be stitched out

Step through open designsCut, copy, paste or delete a selected block
Select stitches or a block

Resize or scale a block
Adjust the selection

Arrange and resize a blockChange color and stitch order View all designs
Select a hoop
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Click and drag inside the block to move it, or use the arrow keys on the keyboard to nudge 
it in small amounts for accurate positioning. Click and drag the square corner handles to 
scale the block with constant stitch count (white handles) or resize with constant density 
(blue handles). Click and drag the round rotate handle to rotate the block freely. Click and 
drag the center of rotation  to rotate around a different point. Click the triangular 
handles to flip the block horizontally or vertically. Click and drag the trapezoidal bottom 
right corner handles  to skew the block.
A block can also be resized/scaled and rotated precisely using the Modify Block  dialog.
The resize handles will be round instead of square if any part of the selection is outside the 
hoop boundary.

When a block is pasted into an embroidery it is automatically selected as the current 
block, and Box Select is activated. The block is attached to the last visible stitch.

Click the work area outside a block to deselect it. The selection box around the block will 
disappear. 
Right-click to turn off the current select function without deselecting the block.

Block Select Functions
Use Box Select  to select stitches in a rectangular area. Click Box 
Select and the pointer changes to the box select pointer . Click and 
drag around the area you want to select. When you release the mouse 
button, the block will show you the extent of the selection. 

Use Freehand Select  to select a block of stitches within an area of any 
shape. Click Freehand Select and the pointer changes to the freehand 
select pointer , then click and drag to draw an irregular outline 
around the desired area. When you release the mouse the area is closed 
automatically with a straight line between the last mouse position and 
the start position.

Use Freehand Point Select  to select a block of stitches within an area 
of any shape, defined by a series of points. Click Freehand Point Select 
and the pointer changes to the Freehand point select pointer . Click a 
series of points to create an irregular outline of straight or curved lines 
around the desired area, using Ctrl+click to place a square (straight line) 

Square handles show that the whole 
embroidery is inside the hoop

Round handles show that at least part of the 
embroidery is outside the hoop
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point. Click and drag  to reposition an existing point. Click Delete to remove the last–
placed point. Right-click when the area is complete.

Use Color Block Select  to select a block of stitches by thread color. Click the icon, then 
click a visible color on the embroidery. The block will be selected according to the visible 
stitches of the color you clicked.

Select All Visible  is a one-click function that selects all visible stitches in the current 
embroidery. Click outside the block to deselect.

Use Select None  to deselect all embroideries and blocks in the work area, including any 
outside the hoop.

Use Replace Selection  to replace the currently selected stitches with the new selection. 
Use Add to Selection  with any select function to add the new selection to the currently 
selected stitches. Use Remove from Selection  with any select function to remove the 
new selection from the currently selected stitches.

Move and Resize a Block
Move a block using click and drag. Click inside the block and drag it to the required 
position. Any stitches which lead to or from the block will be stretched to accommodate 
the new position of the stitches moved in the block.

When you drag the selection, an outline within the selection box shows the shape of the block. If you 

accidentally move the center of rotation , simply click and drag inside the selection box again.

A block of stitches can be moved in small amounts to nudge it accurately into the desired 
position. Use the arrow keys on the keyboard to nudge a block.

Use Resize  to switch between resize and scale. Use resize to change the size of the 
block and retain constant density. Use scale to change the size of the block and retain 
constant stitch count. The handles on the block selection show when resize or scale is 
selected.

Click and drag one of the square corner handles to resize or scale. Hold down Ctrl as you 
click and drag to resize or scale proportionally. Hold down Shift to resize or scale from the 
center.

Alternatively, click Modify Block  and enter the desired percentage values in the 
Height % and Width % boxes in the Modify Block dialog box, then click Apply. After 

Blue handles for resize White handles for scale
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changing the percentage, you can see what the actual height and width will be in 
millimeters.

Resize should be a single step operation. If necessary, use Undo and try again if the desired effect is not 
achieved at the first attempt. Repeated use of Resize on the same area of stitches will lower the quality of 
stitching.

If desired, use Resize Preferences  to adjust the resize settings. This may be useful when making large 
changes to the size of a block. The Stitch Optimizer is also used automatically after each resize, as selected 
by default in Resize Preferences.

Rotate Block
Rotate the selected block of stitches to any degree using free rotation with the mouse, 
entering a specific angle or rotating in 45 degree steps.

Click and drag the rotation handle to rotate the 
block freely to any angle. If desired, move the 
center of rotation  before rotating the block.

The selection box around the block and the 
block outline are rotated around the center of 
rotation. When you release the mouse button, 
the block will be redrawn in its new position.

The center of rotation  is initially shown in 
the middle of the block. Click on or within the 
center of rotation, then drag it to any position in the embroidery. This changes the pivot 
point around which the block rotates for any of the rotation methods.

When the block is moved, scaled or resized, the center of rotation is returned to the center of the block.

Rotate 45
Use Rotate 45  to rotate the block or selected area of stitches in 45 degree steps. If 
desired, move the center of rotation  before rotating the block.

Modify Block
Use the Modify Block  dialog box to show and change the size and rotation of the 
currently selected block, and to skew the selected block.

Modify the currently selected block as desired, then click Apply to show your changes in 
the work area.

Resize a Dragonfly Embroidery
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\Premier+2\Samples\Modify\Stitch, scroll down to the thumbnail of Perky 

Dragonfly. 
4 Click to load the embroidery.

A larger size would be more suitable when creating cutwork, for example.
5 Ensure the Home tab is selected, and click Box Select .
6 Click and drag to draw a rectangle around the dragonfly. 

Rotate

Center of
Rotation

Handle
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7 Release the mouse button and the dragonfly is surrounded by a 
selection box with white handles.

8 Click Resize . The handles on the selection box become blue.
The blue handles indicate that when the size of the embroidery is 
changed it will be resized. The stitches are recalculated to maintain the 
original density.

9 Note the number of stitches in the embroidery. You can see this in 
the Information area on the Design panel, or in the Control Strip.

10 Click Modify Block . The Modify Block dialog box appears.
11 In the Size section, ensure Proportional is checked, then change 

Height percentage  to 125%. 
The Width percentage will increase by the same amount.

12 Click Apply. The dragonfly increases in size, and the number of 
stitches is increased from 4337 to approximately 4387.

13 Close the Modify Block dialog box.
14 Left-click outside the select box to deselect the stitches.

Flip or Skew Block
Mirror a block of stitches vertically or 
horizontally using the flip handles on the block 
selection box.

If long stitches go across the block after it is mirrored, use 
Reverse Order to prevent this. Alternatively, reselect the 
block and try again.
Click the Flip Horizontal handle to mirror a block 
horizontally. Click the Flip Vertical handle to 
mirror a block vertically.

Skew a block vertically or horizontally using the 
trapezoidal Skew handles  in the bottom right corner of the block selection box.

Skew will change the density of stitching. It is recommended to use Stitch Optimizer  afterwards.

Center in Hoop
Use Center in Hoop  to move the embroidery to the center of the hoop and, if 
necessary, add a hoop movement so that the embroidery starts from the center of the 
hoop.

Reverse Order
Reverse Order  is used to reverse the stitch order of a selected block. For example, if a 
block of stitches making a shape from left to right is selected and mirrored horizontally, 
using Reverse Order will prevent long movement stitches going across the shape after it 
has been mirrored.

Flip Vertical Handle

Flip
Horizontal

Handle
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4Modifying Stitches and Blocks

Modify Stitch
When using the Modify Stitch functions, after selecting the function click on the stitch that 
you want to modify.

When any of the Modify Stitch functions in the Modify tab except Edit Stop Command are selected, the 
command markers are enlarged to make them easier to identify. (When Edit Stop Command is selected 
only the Stop markers are enlarged.)

Insert Color Command
Use Insert Color Command  to add a new color change at the point where you click.

Click the icon and the pointer changes to the insert color pointer . Then click on the 
stitch where you want the color change. The Color Selection dialog box is displayed for 
you to select the thread color for the new color change. After you have selected a thread 
color, the new Color Change command  is shown by a blue circle with a C.

Change Alternate Petal Colors in a Flower
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\Premier+2\Samples\Modify\Stitch load the 'Flower Pink’ 

embroidery.
4 Ensure that the Design Panel is available.
5 Double-click the first color in the worksheet and the Color Selection box appears.
6 Click Show All Thread Ranges, then click the drop-down arrow on the Thread 

Range box and scroll up to select Robison-Anton Rayon Twist 35.
7 Browse for thread number 79020 (Baby Pink) in the list and select it.

Alternatively, enter 79020 in the Find Thread box.
8 Click OK to close the Color Selection box, and the thread color of the petals will 

change.
9 Change the second color in the worksheet to Robison-Anton Metallic J 40, thread 

number 1001 (Gov’t. Gold), then click OK. The center color changes.
10 Click Draw Next Color Block  to show only the first color in the worksheet.
11 Click Zoom To Rectangle . The mouse pointer will change to the zoom 

pointer .
12 Click and drag to draw a rectangle inside the flower, a little way inside the tips of the petals, then 

release the mouse button to zoom in.
13 In the View tab, click 2D View with Stitch Points, so that the flower is shown in 2D, and you can see the 

black dots that represent the stitch points in the embroidery.

Adjust stitches Break the design in two

Automatic basting line

Optimize stitchout
Automatically add trims

Change to a single color
Create cutwork needle lines

Morph all visible stitches

Morph stitches where you click

Insert a Tie On or Tie Off stitch

Alignment subdesign

Insert stitches where you click
Insert color & trim commands

Delete commands

Insert & Edit Stop Commands
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It may be easier to visualize the design if you enable Ghost Mode .
14 Move the Draw From Start slider bar so that the first petal is hidden, 

leaving only the Trim command  at the end. There should be a 
stitch point at the center of the Trim command marker. The start 
stitch is shown as 280.
Stitch numbers are given as guides only. It is more important to ensure 
that the correct stitches are hidden or left showing than to follow the exact stitch numbers.
To get to the desired stitch number quickly, drag the slider to a nearby stitch number, then click the arrows 
in the stitch number boxes to adjust the number in single steps

15 Click the Modify tab.
16 Click Insert Color Command . The Trim command markers become much larger, and the mouse 

pointer changes to the insert color command pointer .
17 Click on the pink line showing the stitch to the right of the Trim 

command at the end of the hidden petal. The Color Selection box will 
appear.

18 Choose Show All Thread Ranges, then set the Thread Range to Robison-
Anton Rayon Swirl 35.

19 Select thread number 017 (Soap Stone), then click OK to close the Color 
Selection box. The thread color of the visible petals will change.
The Trim command is replaced, as it is not necessary to have a Trim and 
Color Change adjacent to each other.

20 Move the left Draw Range slider bar so that the start stitch is shown as 
537. This will hide the next petal, leaving only the Trim Command and 
its stitch point at the end.

21 Ensure that Insert Color Command  is still selected, and click on the stitch below the Trim 
Command at the end of the hidden petal.

22 In the Color Selection box select thread number 79020 (Baby Pink) from Robison-Anton Rayon Twist 
35 and click OK. The thread color of the visible petals will change.

23 Move the left Draw Range slider bar so that the start stitch is shown as 794.
24 Ensure that Insert Color Command  is still selected, and click on the stitch below the Trim 

Command at the end of the hidden petal.
25 In the Color Selection box select thread number 017 (Soap Stone) from Robison-Anton Rayon Swirl 35 

and click OK.
26 Look at the Design Panel.

Notice that the new color blocks are shown in the color worksheet and Control Strip as they are added, 
alternating between the Swirl and Twist colors.

27 Move the left Draw Range slider bar so that the start stitch is shown as 1062.
28 Ensure that Insert Color Command  is still selected, and click on the stitch to the left of the Trim 

Command at the end of the hidden petal.
29 In the Color Selection box select thread number 79020 (Baby Pink) from 

Robison-Anton Rayon Twist 35 and click OK.
30 Move the left Draw Range slider bar so that the start stitch is shown as 1330.
31 Ensure that Insert Color Command  is still selected, and click on the stitch 

above the Trim Command at the end of the hidden petal.
32 In the Color Selection box select thread number 017 (Soap Stone) from 

Robison-Anton Rayon Swirl 35 and click OK.
33 Right-click to deselect Insert Color Command.
34 Click Draw All Stitches .
35 In the View tab, click 3D View  and then click Zoom to Fit .

Insert Stop Command
Use Insert Stop Command  to add a command which instructs the embroidery 
machine to stop at the point where you click, displaying a message. A Stop command  
is shown by a red circle containing the letter S.
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Insert a Stop Command
1 Open an embroidery, then click the Modify tab.
2 Click Insert Stop Command  and the pointer changes to the insert stop pointer . 
3 Click on a stitch. The Stop dialog box opens.
4 Use the Quick Text drop-down menu to insert a stitchout hint, or enter a message. 
5 Click OK to place the Stop Command.

A large Stop command marker  shows the place where the command was inserted.
The Stop command marker will become smaller when Insert Stop Command is deselected.
Use Edit Stop Command  to add or change the message 
or stitchout hint for any existing Stop Command. 

Add a stitchout hint to a Stop Command in the Stop dialog 
box. Select a Quick Text comment from the drop-down 
menu, or enter text in the Comment text field. Click OK to 
save the text. Up to 200 characters may be entered.

Insert Trim Command
Use Insert Trim Command  to add a command which instructs some embroidery 
machines to cut the thread. A Trim command  is shown by a green circle containing the 
letter T. It becomes smaller when Insert Trim Command is deselected.

When adding trims to an embroidery, first use Automatically Add Trim Commands , then add any 
additional trims with Insert Trim Command. To add trims automatically to an embroidery with no trims 
when it is opened, set "Add trims automatically when opening a file" in the General section of Preferences. 
Click Insert Trim Command and the pointer changes to the insert trim pointer . Then 
click on a stitch. When a trim is inserted, the stitch disappears.

Delete Commands
Use Delete Commands  to delete an unwanted Color Change, Stop or Trim command. 
Select Delete Commands , then click on a command marker to delete it.

Showing Commands
Use Commands  to show or hide the command markers for Color Change , Stop , 
Appliqué  and Trim . 

Edit and Add Stitches
It may be helpful to select 2D View with Stitch Points  and zoom in 
close enough to see the separate stitch points. To select a stitch, click 
Single Stitch , then click a stitch point. A box appears around the 
point to show that it is selected. Click and drag the box to move the 
stitch point. If desired, use Delete  to delete the stitch point.

Insert Stitches
Use Insert Stitches  to add new stitches to an embroidery. Click Insert Stitches and the 
pointer changes to the Insert Stitches pointer . The stitches will be added using the 
thread color where you insert the stitches. Click Delete to delete the last point placed. If 
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you need to use a different color for the stitches, insert color changes before and after the 
new stitches have been added. Right-click twice to deselect.

You may not start from a stitch point where there is a command (Color Change, Stop or Trim).
Use Insert Stitches to add more underlay to an embroidery, to make a new section of an 
embroidery, or to change an embroidery into an appliqué embroidery.

Inserting Tie Stitches
Create a tie stitch automatically, to hold down the stitching at the point you click. 
Typically, tie stitches are used at the beginning and end of areas of satin or fill. 

You can add tie stitches to an embroidery where sections are coming loose after stitching out.
Use Insert Tie On  to add a tie stitch at the beginning of the stitch area to be secured. 
The stitches making up the tie stitch are inserted in the embroidery before the first stitch 
point of the selected stitch.

Use Insert Tie Off  to add a tie stitch at the end of the stitch area to be secured. The 
stitches making up the tie stitch are inserted in the embroidery after the selected stitch.

Working with Stitches and Blocks
The Clipboard Block shows the current block that can be pasted 
into your embroideries. It shows the most recent block of stitches 
or embroidery that has been cut or copied from PREMIER+™ 2 
Modify or another PREMIER+™ 2 Embroidery System module.

Click in the clipboard to remove the current Clipboard Block.
Use Cut  to remove the whole embroidery or the currently selected block of stitches 
from the embroidery and make it the Clipboard Block.

Use Copy  to make a copy of the whole embroidery or the currently selected block of 
stitches. The copy becomes the Clipboard Block. Use Edit, Copy All  to make a copy of 
all visible stitches in all designs. 

Use Paste  to insert the Clipboard Block into the embroidery by attaching it to the last 
currently visible stitch. The Clipboard Block shows the current stitches that will be pasted.

The copied block will be inserted at the same position in the hoop as the original block.
Use Paste into New Window in the Paste menu to paste the embroidery in the Clipboard 
into a new window. Use Paste as Design in the Paste menu to paste the embroidery in the 
Clipboard into the current window as a new subdesign within the multipart design.

Use Duplicate  to make a copy of the whole embroidery or the currently selected block, 
which is automatically pasted on the work area below and to the right of the original and 
after the selected block in the stitch sequence .

Use Delete  to delete all visible stitches, or a block of stitches after it has been selected 
using one of the block selection methods. When you have a single stitch selected, 
Delete  will remove the stitch point.

Use Undo  to reverse the last action. Use Redo  to reverse the last action that was 
undone by Undo. If you are not satisfied with the result, click Undo .
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5Borders and Appliqué

Create Borders and Appliqué Areas

Use the Border tab to make a new embroidery by adding a satin, running, triple or motif 
border, optionally with placement stitches and fabric for appliqué. Use a preset shape for 
the border, draw your own freehand shape, or create a border automatically around an 
embroidery or selected stitches. There are three types of border:

 Create External Border 
Remove the stitches outside the shape that has been drawn and add a border around the 
stitches

 Create Internal Border 
Remove the stitches inside the shape that has been drawn and add a border inside the 
stitches

 Create Overlay Border 
Add the border on top of or with the existing embroidery

If desired, select Add Appliqué  to use appliqué with your border, then draw the 
desired border/appliqué shape. Use either a preset shape with Draw Border Shape  or 
draw your own Border Shape  with Freehand Tablet Border  or Freehand Point 
Border . Move, scale, rotate and mirror the border shape as desired. Use the desired 
Create Border function to create the border shape.

The border is always added at the end of the embroidery. If an appliqué option is used, the 
stitches for placing the appliqué fabric are added at the beginning of the embroidery.

All stitches, including stitches you may have hidden, are used when the new embroidery is created. If you 

wish to use only the visible stitches, use Select All Visible  to select all the visible stitches, Copy  the 
stitches, and use Paste into New Window. Then draw a border shape and use the desired border and 
appliqué functions.

Border Line
Use Freehand Tablet Border Line  to draw a line to create a border, optionally with 
appliqué. Draw a line, then release the mouse button to finish the line. The line is closed 
automatically to form a shape. Move the nodes to adjust the shape. Click Delete to remove 
the last–placed point. Then select a border option.

Draw a freehand line
Draw a preset shape

Select a shape for drawing

Choose a border stitch type

Add appliqué to the border
Choose an appliqué fabric

Choose the border line settings

Choose appliqué settings

Create an internal, external 
or overlay border

Create a border automatically
Set the automatic border margin
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Use Freehand Point Border Line  to create a border of any 
shape by placing points. Click Freehand Point Border Line and 
the pointer changes to the add point pointer . Click a series of 
points to create an irregular outline of curved and straight lines 
around the desired area. Use Ctrl and click to place a square 
(straight line) node. Click Delete to remove the last–placed point. 
Select a border type when the border is complete.

Border Shape
Use Border Shape  to draw an outline with the border shape 
currently selected in the gallery of preset shapes. Click the drop-
down arrow to the right of the border shapes gallery, and scroll to 
select the desired shape in the list. Click Draw Border Shape , 
then click and drag over the embroidery to draw a rectangle that 
sets the size of the shape. Hold down Ctrl to draw in proportion.

When the mouse button is released, the shape will be shown as a 
red line, with handles to resize, flip and rotate the shape.

For best results when drawing shapes with sharp points, it is recommended to 
hold down Ctrl so that the shape is perfectly in proportion.

Border Embroidery
Use Border Embroidery  to create a border automatically around 
the selected embroidery or stitches, using an internal, external or overlay border, 
optionally with appliqué. Use Margin to set the distance between the selected stitches 
and the border.

Draw a Border Around an Embroidery Automatically
1 Select the Border tab in the ribbon bar.
2 Load an embroidery design.
3 In Stitch Type, choose the desired line type for the border and use Options 

 to select its settings.
4 If desired, select Add Appliqué  to use appliqué with your border, select 

an appliqué fabric  and click Options  to set the appliqué type.
5 Select the part of the design that you want to surround by a border.

If nothing is selected, the border will be placed around the whole embroidery.
6 Set the Margin to the desired distance from the stitches in the embroidery.
7 Click Border Embroidery . The position for the border is shown by a red 

and cyan dashed line.

8 If desired, adjust the Margin setting. The position of the preview line will 
change.
Holes within the embroidery, and some appliqué areas, will also have a border, 
each with its own color block. To remove one of these internal borders, after 
creation select its color block and delete those stitches.

9 Click to select an External, Internal or Overlay Border. The border is placed 
around the embroidery.
Right-click to deselect Border Embroidery without placing a border.
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Border Stitch Type
Select a border stitch type, and use Options  to choose its settings in the dialog box. 
Choose from: Satin Line , Motif Line , Running Stitch  and Triple Stitch .

Create Border
Use the Create Border options to create a new embroidery with a border in the shape you 
have drawn and placed. There are three Create Border functions:

Add a Satin Border to the Sweet Rose Embroidery
1 Change the background color to pink. 
2 Click File, New  to open a new window.
3 In the Quick Access toolbar, click Insert .
4 In the folder Documents\Premier+2\Samples\Modify\Stitch load 

the 'Sweet Rose with Buttons' embroidery.
5 Click the Border tab.
6 In Stitch Type, ensure that Satin Line  is selected, then click 

Options .
7 In Satin Line, set the Width to 3.5mm, set Density to 4, and ensure 

Underlay is selected. Click OK to close the Satin Line dialog box.
8 Click Draw Border Shape .
9 In the Shapes drop-down list, select Shape 1 (a rectangle).
10 Click and drag to draw a rectangle that surrounds the embroidery, 

leaving a very small gap below.
The gap ensures that the border will not cover the embossed lettering.

11 Click Create Overlay Border . A border is placed around the 
embroidery.
Alternatively, to create a quick border with more rounded corners, use 
Border Embroidery  with the Margin set to 2mm.

12 In the color worksheet, select the color at the bottom (the color for 
the border).

13 Click Thread Color . The Color Selection dialog box appears.
14 Ensure that Robison-Anton Rayon 40 is selected in the list of thread 

ranges.
15 Browse for thread number 2500 (New Berry) in the list and select it, or type 2500 in the Find Thread 

box. Click OK. The thread color is now a plum color.

Create External Border Create Internal Border Create Overlay Border

Create External Border  will 
remove the stitches outside the 
shape that has been drawn and 
add a border around the stitches.

Create Internal Border  will 
remove the stitches inside the 
shape that has been drawn and 
add a border inside the stitches.

Create Overlay Border  will 
add the border on top of the 
embroidery.
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Add Appliqué
Use Add Appliqué  to add appliqué to the border that you create. Appliqué placement 
stitches are automatically added to the border that you draw.

Select Add Appliqué , and create the desired shape with Border Embroidery , Draw 
Border Shape , Freehand Tablet  or Freehand Point  Border. Move, scale, rotate 
and mirror the shape as desired. Use the desired Create Border function: External , 
Internal  or Overlay  to create the embroidery. 

A new color block, using the same color as the border is placed at the beginning of the 
embroidery for the appliqué placement stitches. The appliqué placement stitches use the 
method, appliqué piece margin, running stitch length and double stitch length set in 
Appliqué Options . A Color Change is also placed at the beginning of the border line, using 
the default border color. The border uses stitch type settings set in the Line Options.

Draw Internal Heart Appliqué
1 Click the Hoop icon . From the Universal Hoop Group, set the Hoop Size to 240mm x 150mm - 

Universal Large Hoop 2. Set the Orientation to Rotated. Click OK.
2 Click File, New  to open a new window.
3 In the Quick Access toolbar, click Insert .
4 In the folder Documents\Premier+2\Samples\Modify\Stitch load the 'Scalloped Heart' embroidery.
5 Click the View tab. In Grid, ensure that the grid size is is set to 5mm. Click Grid Numbered Full .
6 Click the Border tab.
7 Set the Stitch Type to Satin Line .
8 In the Stitch Type area, click Options, and in the Satin Line dialog box, ensure that the Width for Satin 

Line is set to 3.5mm and the Density is set to 4. Click OK.
9 In the Appliqué section, click Add Appliqué , then click Options . In the Appliqué Options 

dialog, in Appliqué Method ensure that the first method (Standard Appliqué) is selected. 
10 Ensure Running Stitch Length is set to 2.0mm and Double Stitch Length is set to 2.0mm.
11 Click OK to close the Appliqué Options dialog box.

External Appliqué Internal Appliqué Overlay Appliqué

Create External Border  with 
appliqué removes the stitches 
outside the shape that has 
been drawn. It then adds 
appliqué placement stitches at 
the beginning of the 
embroidery and a border 
around the stitches.

Create Internal Border  with 
appliqué removes the stitches 
inside the shape that has been 
drawn. It then adds appliqué 
placement stitches at the 
beginning of the embroidery 
and a border inside the 
stitches.

Create Overlay Border  with 
appliqué keeps all the stitches 
in the embroidery. It then adds 
appliqué placement stitches at 
the beginning of the 
embroidery and a border on 
top of the embroidery.
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12 Click Select Fabric . In the Applique Selection dialog box, ensure that 
Quick is selected.

13 In Quick Colors, select the orange in row 4, column 6.
14 Ensure that the Texture is set to Woven, then click OK.
15 Click the drop-down arrow next to the currently selected preset border 

shape and select shape 31, the first heart shape, from the list.
16 In the color worksheet on the Design Panel, click the check box for the first 

thread color to hide the stitches of the lace.
17 Click Draw Border Shape .
18 Hold down Ctrl to draw a proportional shape, and draw from left grid 

line 6 to right grid line 6, so that the box is 12 grid squares wide.
19 Release the mouse button and the heart shape appears as a red line.
20 Click and drag inside the small heart shape and move it to the center 

of the hoop. The shape is centered when the points of the flip handles 
are on the center grid lines.

21 Click Create Internal Border . The lace stitches in the central part of 
the embroidery are replaced by an appliqué area.

22 Click the Home tab.
23 In the Design Select area there are two subdesigns: a heart with an 

internal and external border, and a lace heart with no border.  Select 
the lace heart and click Delete .

24 The first and last colors in the embroidery should match the red for 
the external border. Select the first color.
These are the appliqué placement stitches.

25 Click the Thread Color button  and change the thread color to 
Sulky Rayon 40 thread number 1246 (Orange Flame).

26 Select the final color (the internal border) and change the thread color 
to Sulky Rayon 40 thread number 1246 (Orange Flame).

Select Fabric
Use Select Fabric  to audition a fabric for your appliqué in the Appliqué Selection 
dialog box. Click Select Fabric  and the Appliqué Selection dialog box appears. 

Appliqué Selection

Select a Quick Color & texture

Choose an appliqué type

Choose a system fabric

Load an individual picture 

Preview the appliqué fabric

Reuse a recent fabric

or add a new one

for printed appliqué

Print a sheet of appliqué fabric

Set the appliqué border margin
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View and Adjust Appliqué Pieces

Appliqué Piece
Use the Appliqué Piece functions to add appliqué fabric to an existing design with 
appliqué areas, and to adjust appliqué areas within a design.

Use Express Appliqué  to automatically find appliqué areas in some existing embroideries.

Appliqué Outline
Use the Appliqué Outline  functions to draw or place points to define a line of any 
shape to create an appliqué outline.

Hold down Ctrl to place a corner point when creating or editing a line. Click Delete to remove the last-
placed point.
Use Freehand Tablet Appliqué Outline  to draw a line of any shape to create an 
appliqué outline. Select a Color Command or Stop Command to start the appliqué piece 
from, then draw the outline. When hovering over a Color Command you will see the 
stitching that follows it. Release the mouse button to complete the line. Right-click, and 
the Appliqué Selection dialog box opens. Select a fabric, then click OK to place the 
Appliqué Piece.

Use Freehand Point Appliqué Outline  to place points to define a line of any shape to 
create an appliqué outline. Select a Color Command or Stop Command to start the 
appliqué piece from, then place points to draw the outline. When hovering over a Color 
Command you will see the stitching that follows it. Right-click to finish, and the Appliqué 
Selection dialog box opens. Select a fabric, then click OK to place the Appliqué Piece.

Add an Appliqué Fabric to a Flower Bouquet Embroidery
1 Click Change Hoop . From the Universal Hoop Group, set the Hoop Size to 100mm x 100mm - 

Universal Square Hoop 1. Click OK.
2 Click File, New  to open a new window.
3 In the Quick Access toolbar, click Insert .
4 In the folder Documents\Premier+2\Samples\Modify\Stitch load the 

'Appliqué Bouquet' .vp3 format embroidery.
5 Click the View tab.
6 Ensure that Commands  is selected.
7 In the Design Panel there are three green color blocks at the top of 

the worksheet. Use the pointer to highlight the names; they are all 
the same thread.
The appliqué stitch lines in this embroidery are marked by Color 
Commands rather than Stop Commands.

Audition a fabric for the 

Delete an appliqué piece
Insert and Delete points in an appliqué area outline

Select an appliqué area, or move to another areaDefine the outline of an appliqué area
Cut a hole in an appliqué area

appliqué

Add fabric to an appliqué area automatically
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8 Below the Control Strip, click Draw Next Color Block . The running stitch line outlining the 
embroidery is shown, with a Color command  marker at the top.
Hover over the Color Command and you will see the stitching that follows it, which is the outline of the 
appliqué area.

9 In the bottom left corner of the window, click the up arrow next to the 
numbers box to the right. At the top of the embroidery a second Color 
command marker  appears.
This is the start of the stitch line that secures the appliqué fabric.

10 Click the Appliqué tab.
11 In the Appliqué Outline  drop-down menu, click Freehand Point 

Appliqué Outline .
12 Click the second Color command marker  (the upper one).
13 Click to place points just outside the outline of the appliqué area.

Hold down Ctrl to place a corner point, and click Delete  on the Home 
tab if you need to remove the last-placed point.
The second line of stitching lies just outside the first line, so add a slight 
margin for the fabric to be secured by this line.

14 Place the last point at the Color command where you started. Don’t worry if your line is uneven; you 
can change it afterwards.

15 Move the points on the line to reshape it as desired.
16 Right-click. The Appliqué Selection dialog box opens.
17 In Appliqué Type, ensure that Quick is selected.
18 Click the arrow to the right of the Quick Colors, and select Fall from the drop-down menu.
19 Click the color in row 3, column 1 (a pale green).
20 Ensure that the Texture is set to Woven, then click OK. The appliqué piece can be seen in the work 

area, and the other appliqué options are available in the ribbon bar.
21 Below the Control Strip, click Draw All Stitches .
22 Click and drag any points in your appliqué line that lie outside the edge of the embroidery, so that 

none of the fabric overlaps.

Use Insert Points  to add points to this line, and Delete Points  to remove any unwanted points.
23 Click outside the embroidery. You can no longer see the outline of the 

appliqué piece.
Select Piece  is available. This indicates that the embroidery contains an 
appliqué  piece.

24 Click Next Piece . Your appliqué  piece is selected again.
25 Click Select Fabric . The Appliqué Selection dialog box opens again, 

with your selected fabric previewed.
Use the Appliqué Selection dialog box to change the fabric for existing 
appliqué.

26 Click Cancel to close the dialog box.
27 Click Design Player , then click Start  to play the design from the 

beginning. The appliqué is placed after the first line of running stitch, and before the second line.
You can also view the structure of the embroidery using the sliders on the Control Strip.

28 In the Quick Access toolbar, click Save As . Save the embroidery in your My Designs folder as 
Appliqué Bouquet with Fabric.vp4. In .vp4 format the appliqué information is saved.

29 Close PREMIER+™ 2 Modify, then open it again.
30 Open the file you just saved. You can see the appliqué piece that you created.

Appliqué Hole
Use the Appliqué Hole  functions to draw or place points to define a line of any shape 
to create a hole within the selected appliqué area. Select the desired Appliqué Piece so its 
points are displayed, then draw the hole. 

Hold down Ctrl to place a corner point. Click Delete to remove the last-placed point.



PREMIER+™ 2 Modify   Borders and Appliqué              29

Use Freehand Tablet Appliqué Hole  to draw a line of any shape to create a hole within 
the selected appliqué area. Select the desired Appliqué Piece so its points are displayed, 
then draw a line to form the hole. Release the mouse button to complete the line. Right-
click, and any appliqué fabric is removed from the hole.

Use Freehand Point Appliqué Hole  to place points to define a line of any shape to 
create a hole within the selected appliqué area. Select the desired Appliqué Piece so its 
points are displayed, then place points to draw a hole. Right-click, and any appliqué fabric 
is removed from the hole.

Draw a Hole in an Appliqué Area
1 Click the Border tab, and click Add Appliqué.
2 Select the fabric of your choice.
3 Use Border Shape  and draw an external border .
4 Click the Appliqué tab.
5 In Appliqué Hole , select Freehand Tablet Appliqué Hole .

If  Appliqué Hole is not available, click Next Piece to select the appliqué piece, 
then click Appliqué Hole.

6 Draw a circle in the middle of your appliqué area.
7 Right-click to create the hole.

Express Appliqué
Use Express Appliqué  to automatically find appliqué stitches within the visible stitches 
of some existing embroideries, and apply an appliqué fabric to them.

Multiple appliqué areas can be detected in the same subdesign. Use the selection tools and Control Strip to 
hide areas where you don’t want appliqué added.
In the Appliqué window, select an appliqué embroidery with no fabric, click Express 
Appliqué , then add a fabric in the Appliqué Selection dialog box. Optionally, adjust the 
overlap margin.

Add Appliqué to a Sun Embroidery
1 Click Change Hoop . From the Universal Hoop Group, set the Hoop Size to 200mm x 200mm - 

Universal Square Hoop 3. Click OK.
2 Click File, New  to open a new window.
3 In the Quick Access toolbar, click Insert .
4 Browse to the folder 

Documents\Premier+2\Samples\ 
Premier+Emb\Stitch and load the embroidery 
'Sunshine Applique Large with Lettering'.
Click Yes when told that the design will be fixed as 
stitches. The lettering is the part of the design that 
will be fixed as stitches.

5 In the Home tab, click to select the first subdesign 
in the Design Select area (the sun embroidery).
This is the part of the design with an appliqué area.

6 Click the Appliqué tab.
7 Click Express Appliqué . The Appliqué Selection 

dialog box opens so you can choose a fabric for 
your appliqué.
Express Appliqué detects the appliqué placement stitches and inserts appliqué fabric in that area.

8 In Appliqué Type, click Fabric.
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9 Click Load Previously Saved Fabric  to load a fabric 
in the Picture Viewer.

10 Browse to the folder General\Lattice.
11 Click the fabric Lattice 1 - 18, then click OK. The Picture 

Viewer will close and the fabric will be shown in the 
Appliqué Selection dialog box.
If desired, adjust the Appliqué Piece Margin.

12 Click OK to close the Appliqué Selection dialog box. The 
fabric is shown under the sun’s face, as if you had 
stitched it down as an appliqué.

13 In the Quick Access toolbar, click Life View .
14 Move the Zoom Bar slider to the right so that you can see the 

embroidery clearly.
Note that the threads for the sun’s face and lettering are white.

15 Click Solar Reactive . The white threads turn yellow and 
orange.

16 In the Quick Access toolbar, click Save As  and save the 
embroidery with the appliqué and background as ’Sunshine 
Applique Large with Lettering and Applique’.
The sun and lettering will be stored separately within this multipart 
embroidery, making further adjustment easier.

Select Appliqué Piece Functions
Use Select Piece  to select an Appliqué Piece to alter its shape and preview or adjust its 
fabric. Click Select Piece , and then click the desired Appliqué Piece.

Use Next Piece  to select the next Appliqué Piece in the stitchout order. Use Previous 
Piece  to select the previous Appliqué Piece in the stitchout order.

Next Piece and Previous Piece will select an appliqué piece even if no appliqué piece is currently selected.

Insert and Delete Points
Use Insert Points  to add new points into the currently selected Appliqué Piece. Select 
the desired appliqué piece, then click Insert Points . The pointer changes to the plus 
pointer . Click to add a point to the outline of the selected area. Right-click to finish.

Use Delete Points  to delete points from the selected Appliqué Piece. Select the desired 
appliqué piece, then click Delete Points . The pointer changes to the minus pointer . 
Click to remove a point from the outline of the selected area.  Right-click to finish.

Delete Piece
Use Delete Piece  to delete the currently selected Appliqué Piece with its outline. Select 
the desired appliqué piece, then click Delete Piece . The appliqué  piece is removed.

Export Appliqué
Use Export Appliqué Pieces  in the File menu to save or print appliqué outlines ready 
for cutting. There are five export methods: save as SVG, DXF of FCM files for use in fabric 
cutters, save as VP4 or VP3 stitch files for use with INSPIRA™ Cutwork Needles, print as an 
outline template to cut around, print directly onto printable fabric or an iron-on transfer, 
or save as SVG files with the fabric image placed as the fill for each shape.
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Border and Appliqué Techniques
There are many ways the Border/Appliqué functions can be used creatively.

Decorative shapes
Use the Overlay option to add border or appliqué 
shapes as decorative additions to an embroidery. 
With the Overlay option, add shapes to the 
embroidery in any position. 

Several small border or appliqué shapes can be 
added to the sides, such as the small hearts in the 
picture. Alternatively, add overlays within the 
embroidery to surround elements of the design.

Appliqué Patch within Bordered Embroidery
First create an External Border around the embroidery. Then create either an Internal 
Border or an Overlay Border with appliqué. If an Overlay Border with appliqué had been 
used in the example above, the Curly Lace embroidery would also have stitched over the 
appliqué fabric in the center, giving a different effect. With other border shapes, it will also 
be effective to place the appliqué shape towards a corner or edge of the External Border.

Create as many appliqué areas as desired. When stitching out, the appliqué fabric inserts 
are placed in the reverse order to the order the appliqué areas were created.

Drawing Border Shapes as the Design
Start a New embroidery. Draw the first border shape as desired, 
then Create External Border. A new embroidery is created that 
only consists of the border. Add further border shapes as desired, 
generally using the Overlay Border option. Use the Select 
functions with Copy and Paste to make identical copies of the 
same shape. Use External and Internal border where you wish to 
cut through previously created border shapes.

Double Border
Create the same border shape twice, one around the other, to make a 
double border. This is effective as an alternative type of frame, and 
works best with simple border shapes. Create the inner border first. 
This effect looks best if the border width and the gap between the 
double borders are approximately the same.

Stamps on a Thick Border
This is ideal for adding text and simple stamps, while also 
framing an embroidery. Use a wide External Border. Then use 
the text stamping (here Segoe Script, Regular 144) found on 
the Emboss tab to create writing on the border. Use other 
stamps and Freehand Tablet/ Point Emboss Line for additional 
decoration.
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6Morphing and Cutwork

Point Morphing
The point morphing effects change the positions of stitches around the point where you 
click. You do not need to click directly on stitches in order to affect them. 

The effect is strongest at the point clicked and gets weaker with distance. Only visible stitches are affected.

 Use Magnet  to pull stitches in towards the point where you click.
 Use Polarize  to push stitches away from the point where you click. This does not 

reverse the effects of a previously applied Magnet.
 Use Twirl  to move stitches around the point where you click, like a swirling spiral. Twirl 

moves the stitches clockwise around the click point, or hold Shift and click for a counter-
clockwise Twirl.

 Use Wave  to move stitches in a wave pattern around the point where you click. The 
effect of Wave is usually clearest on straight lines of stitch points.

Global Morphing
Use Global Morphing  to move all the visible stitches to change the shape and size of 
the embroidery. Choose any of the following global effects:

Pinch
Pinch the stitches 
together in the center, 
while pulling the outer 
stitches away from 
each other

Ripple
Apply a wave pattern 
radiating from the 
center, like dropping 
a stone into a pond.

Skew Horizontal
Slant the stitches 
horizontally to the 
left or right.

Skew Vertical
Slant the stitches 
vertically up or down.

Spherize
Stretch the stitches 
around an imaginary 
sphere.

Twirl
Twist the stitches 
around the center, 
creating a swirling 
effect like a whirlpool

Wave Horizontal
Move the stitches to 
follow a horizontal 
wave pattern.

Wave Vertical
Move the stitches to 
follow a vertical wave 
pattern
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Move one or two slider bars, or type in a number, to adjust the intensity or height and 
frequency for each effect. The Before and After boxes show the original stitches and a 
preview of the effect.

All visible stitches are morphed by the chosen effect. Global Morphing may not be used 
when a block of stitches is selected.

Global Morphing effects are generally more pleasing when applied to an embroidery that is mainly or 
completely symmetrical.
The last effect used and the last settings for each effect are remembered for the current 
PREMIER+™ 2 Modify session.

Add Cutwork Needle Lines
Use the Cutwork  features to draw a cutwork needle line within your design, optimized 
for the INSPIRA™ Cutwork Needle Kit. There are two cutwork options:

 Freehand Tablet Cutwork Line 
 Freehand Point Cutwork Line 

Use cutwork needle lines for reverse appliqué embroideries and free-standing lace, or 
simply to cut out a shape or design.

About Cutwork Needle Lines
The stitch points for cutwork needle lines are very 
close together (0.3mm). 

Where two cutwork needles are used, the two lines 
are represented by the colors red and yellow. Where 
four needles are used, the four lines are red, yellow, 
green and blue. The gaps in these lines represent the 
secure points.

Select a morphing effect

Zoom in and out

Adjust the settings 
for the effect

View the changes
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Surrounding the cutwork lines are the more widely spaced points for the stabilizing line. 
(As the points for the cutwork lines are placed on top of each other, you cannot see the 
separate lines.)

Use the Move and Merge functions for Color Blocks when changing the order of designs with multiple 
areas of cutwork and stabilizing lines, as ColorSort may occasionally merge stabilizing lines in these 
circumstances.

Freehand Tablet Cutwork Line
Use Freehand Tablet Cutwork Line  to draw a line to be cut using cutwork needles. 
Create two or four needle lines automatically, with secure points and stabilizing lines 
according to the settings in Cutwork options.

Draw a line, then release the mouse button to finish the line. The line is closed 
automatically to form a shape. Move the nodes to adjust the line. Click Delete to remove 
the last-placed point. Right-click to place the line on the work area.

Freehand Point Cutwork Line
Use Freehand Point Cutwork Line  to place points to define a line to be cut using 
cutwork needles. Create two or four needle lines automatically, with secure points and 
stabilizing lines according to the selected Cutwork options.

Click to insert points for the line, then adjust the nodes as desired, or place more points. 
Click Delete to remove the last-placed point. Right-click to place the line on the work area.

Cutwork Options
The cutwork needle features allow you to draw a 
cutting line within a design, optimized for the 
INSPIRA™ Cutwork Needles. Use two or four cutwork 
needles, add secure points for fabric stability, and add 
a stabilizing line.

Method
Choose between 2 Cutwork Needles and 4 Cutwork 
Needles. By default 2 needles is selected.

With 2 needles, one needle is used to travel around the shape in one direction and the second needle 
travels around the shape in the opposite direction. With 4 needles a more precise cutting method is used.

Include Secure Points
Select Include Secure Points to create gaps in the cutwork needle line.

This allows the cut fabric to remain attached for stability while all the cutwork needle lines are created. 
Afterwards it can be easily trimmed with scissors.
Set the Distance Between Secure Points from 10mm to 100mm in steps of 1mm. The initial 
setting is 30mm.

Insert a Stabilizing Line of stitching before and/or after the cutwork line. This may be 
helpful for reverse appliqué or free-standing lace, but is not required if you are simply 
cutting out a shape.
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7Modifying an Embroidery

Select, Move and Merge Designs
Use the Design Select area to view the different sections or subdesigns of a multipart 
design. The selected section is displayed in the work area. You can change the order of the 
subdesigns, and select designs to merge together. 

Automatic Ghost Mode is used to show the position of the other parts of the design in the work area.
To see all subdesigns, click the arrow at the bottom right of the Design Select area.
Use Merge Design if you are confident you will not wish to move the subdesigns 
separately, and if there are few or no overlapping stitches.

Decoration subdesigns cannot be merged with others. Alignment subdesigns cannot be moved from the 
beginning of the design or merged with others unless they are changed to standard stitches using the 
Alignment  function.
To remove overlapping stitches when combining designs (unless any of the designs contain appliqué), use 
Export with the Combine and Remove Overlap option checked. 

Move and Merge Designs
1 In the Quick Access toolbar, click Change Hoop , and ensure that the hoop is set to 240mm x 

150mm - Universal Large Hoop 2, and that Rotated is selected in Orientation. Click OK.
2 Click File, New  to open a new window.
3 In the Quick Access toolbar, click Insert .
4 In the folder Documents\Premier+2\Samples\Premier+Emb\Stitch2\Butterflies and Bugs, insert the 

following embroideries in this order: 'Floral Beehive’, ’Three Bees’ and ’Three Dragonflies’.
The embroideries are loaded into the center of the work area.
The embroideries will be shown in the Design Select area in the order that you loaded them. This is also the 
stitching order.

5 In the Design Select area, click the beehive. 
The dragonflies and bees are shown in automatic ghost mode.

6 Click Select All Visible . The beehive is surrounded by a selection box.
7 Drag the beehive embroidery to the bottom of the hoop.
8 In the Design Select area, click Next Design . The three bees are selected. 

Click a design in the Design Select area to select it, or use Previous Design  and Next Design  or the 
Tab key to browse through the sections of a multipart design.

9 Click Select All Visible . The bees are surrounded by a selection box.
10 Drag the bees down and to the left of the hoop, so that the antennae of the bee on the right overlap 

the red and yellow flower by the hive.
11 Select the dragonflies and drag them to the right so that the yellow bubbles underneath the 

dragonfly on the left overlap the wings of the bee to the right of the beehive.
12 Click Life View . This shows the whole project as it will be stitched out.

The hive was loaded first, so it is stitched out before the bees and dragonflies. This works well for the 
overlapping antennae on the left, but on the right it would be better if the bee by the hive was placed over 
the yellow bubbles.

Click to select a design

View previous design
View next design

Merge design with the

Move design up or
down the stitch order

one above
View all subdesigns
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13 Click Cancel to close Life View.
14 In the Design Select area, click the dragonflies.
15 Click the Move Backwards icon  to the right of the worksheet twice to move the dragonflies to the 

top of the stitching order.

The dragonflies are now above the hive in the Design Select area, and will be stitched out first.

Use Move Forwards  to move a design down the stitching order. Alternatively, right-click the design in 
the Design Select area, and choose Move Forwards or Move Backwards from the context menu.

16 In the Design Select area, click the bees to make them the active subdesign, then click Combine with 
Previous . The bee and hive designs are merged, and are both now fully visible in the work area.
Alternatively, you could right-click the beehive in the Design Select area and choose Combine with 
Previous from the context menu.

Compensate Stitches
Use Compensate Stitches  to make a stitch block appear 'bolder' by increasing the 
relative size of the stitches. Stitch lengths are increased at the edges of areas by the 
compensation factor. Only visible stitches are affected. Compensation allows for the 
effects of stitches' tendency to pull in, which varies according to fabric weight and type.

Break Up Stitches
Use Break Up Stitches  to add extra stitch points to the embroidery so that no stitches 
are longer than the specified maximum length. Only visible stitches are affected.

It is recommended to use Break Up Stitches if some very long stitches are left when the Remove Needle 
Points in Fill function is used before stamping.
Use the Extreme setting to break up stitches that are hidden in 3D but visible in 2D.

Design Separator
Use Design Separator  to break an embroidery into two parts. Click Design Separator 
and the pointer changes to the add point pointer . Place a line to enclose the area of 
the embroidery you wish to split. Two new embroideries are automatically created, one for 
each part of the split. The new embroideries are shown as separate subdesigns in the 
Design Select area of the Home tab.

Design Separator can be used to cut out a section of an embroidery you wish to keep, or to 
cut away a section of an embroidery you wish to discard. This may be preferable to making 
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a selection and then using Cut, as Design Separator creates a clean split with traveling 
stitches where it is necessary to move along the split line. Design Separator may also be 
used to split an embroidery into two subdesigns for stitching out.

To automatically split an embroidery for stitching out multiple hoopings in a particular hoop, it is 
recommended to use PREMIER+™ 2 Embroidery Extra or PREMIER+™ 2 Design Aligner.

Density Advisor
Use the Density Advisor  to view the density of the embroidery and, if desired, reduce 
the density where stitch points are tightly packed together. 

View an embroidery with Density Advisor to determine if a particular embroidery may be 
troublesome when it is stitched out. Extensive areas of Very Dense or Super Dense 
stitching may cause difficulties such as thread and needle breakage.

Only visible stitches are affected. It is not available if a block is selected.

The original embroidery A separated section

View the density information

Original embroidery

Density map of the 
embroidery

Select a density level to view

Reduce the density level

Zoom in and out

Adjust embroidery visibility
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Stitch Optimizer
Click Stitch Optimizer  to improve the stitchout of the embroidery, both in speed and 
quality. One of the effects of the Stitch Optimizer is to remove unnecessary short stitches. 
The Stitch Optimizer only affects visible stitches. A confirmation message appears that 
shows the number of stitches removed from the embroidery.

Feel free to try using the Stitch Optimizer on most embroideries, especially after changes have been made 
to an embroidery, before saving the final result.By default, Stitch Optimizer is also used automatically after 
using Resize. Use Stitch Optimizer before using Export , or as part of the Export process. 

Trim Commands
Use Automatically Add Trim Commands  to add Trim Commands before most 
movement stitches in the visible stitch area, and use Remove All Trim Commands  to 
automatically remove all Trim Commands in the design.

To add individual Trim Commands to an embroidery, use Insert Trim Command , and to remove 

individual Trim Commands, use Delete Commands .
To add trims automatically to an embroidery with no trims when it is opened, set "Add trims automatically 
when opening a file" in the Opening Files section of Preferences.

Basting Line
Use a basting line to secure your fabric before beginning embroidery. Basting Line for 
Visible Stitches  places a line around visible stitches, and Basting Line for All Designs  
places a line around all designs on the screen.

Use Basting Line for Visible Stitches  to insert a 
rectangular basting line automatically around the visible 
stitches. This will secure the fabric and stabilizer before 
beginning embroidery.  Set the margin and stitch length in 
Basting Line section of Preferences .

The basting line is automatically created immediately before the 
visible stitches using a color that matches the selected background 
fabric.
Use Basting Line for All Designs  to insert a rectangular 
basting line automatically around all designs on the screen. 
This will secure the fabric and stabilizer before beginning embroidery, and is useful for an 
embroidery project with multiple sections. Set the margin and stitch length in 
Preferences.

The basting line is automatically created as the first subdesign, using a color that matches the selected 
background fabric.
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Alignment Stitches
Use Alignment Stitches  to mark the first or last subdesign as an alignment stitch 
subdesign.

Select the alignment stitch section on the work area using the select tools in the Home 
tab, then click Alignment Stitches  in the Modify tab to flag it as a set of alignment 
stitches.

To mark a set of alignment stitches as a normal subdesign, select the section in the Home tab, and then 

deselect Alignment Stitches  in the Modify tab.

Alignment Stitch Sections
Either the first or last subdesign in a design can be marked as Alignment Stitches. In the 
Home tab an Alignment Stitch subdesign is shown by the letter ‘A’ in the design select 
gallery, rather than the number used for standard subdesigns.

Most editing functions are not available for Alignment Stitch subdesigns. To edit the subdesign, change it 
to a normal subdesign, edit it, then change it back again after editing.

 When a .vp4 design with alignment stitches is Opened , the alignment stitches are 
retained. 

 When a .vp4 design with alignment stitches is Inserted  into a project, the alignment 
stitches are discarded.

To change the alignment stitches in a .vp3 format embroidery into an alignment stitch subdesign, use 
Design Separator  to create two different subdesigns; one for the embroidery, and one for the 
alignment stitches. Then in the Design Select area on the Home tab, move the alignment stitches to the 
front (or back) of the design. With the alignment stitches selected, click Alignment Stitches  in the Modify 
tab to change them into an ’A’ alignment stitch subdesign.
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8Embossing
Use the Emboss features to add beautiful patterns to your embroideries.

Effect
Use Effect to change the prominence of embossed or stamp effects. Select from Standard 
or Super.

The Super effect creates a heavier impression as more needle points are removed surrounding the stamp or 
embossed line.

Needle Points
Use the Emboss Line  functions (Freehand Tablet Emboss Line  
and Freehand Point Emboss Line ) to emboss lines on areas of 
stitching. Use Remove Needle Points in Fill   to remove stitch 
points before embossing.

It is recommended to use Remove Needle Points In Fill on the visible stitches in your 
embroidery before using Stamp Fill.

Freehand Tablet Emboss Line
Use Freehand Tablet Emboss Line  to draw a line to emboss on an area of stitching. To 
move the points in the line after drawing, place the pointer over a node. The Move Node 
pointer  appears. Move the node as desired.

To change a round (curved line) point to a square (straight line) point, hold down the Ctrl 
key and click the point while moving it.

Each line you place, as ended by a right-click, is treated separately by Undo.

1. Original pattern 2. Needle points removed 3. Roses used for Stamp 
Fill

4. Roses in 3D

Select the strength of the emboss or stamp

Emboss a line on a stitch area
Remove the needle points in a fill

Select a stamp category Choose a stamp

Load a .4qb image as a stamp

Create a stamp from text

Set the stamp size & angle

Mirror the selected stamp

Select a Single, Line or stamp Fill
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Freehand Point Emboss Line
Use Freehand Point Emboss Line  to place points to emboss a line on an area of 
stitching.

If underlay stitches are not hidden, they will also have their stitch points removed. If desired, use the Draw 
Range slider bars to hide underlay stitches so they are not affected.

Stamps
Stamps are used to place extra stitch points on existing threads to make a predefined 
symbol or pattern. Stamps can be placed individually, in lines or used to fill all visible 
stitches with the selected pattern. The Stamp functions are found on the Emboss tab.

Select a Stamp
There are 7 named categories of stamps.

Select a set of stamps by name from the drop-down list to the left of the Stamp samples.

Use the arrows at the right of the Stamp 
box to scroll through the stamps within 
a set, or click the drop-down arrow to 
view the stamps gallery.

When you see the desired stamp, click 
it. It will be highlighted with a different 
shade of blue and it will be shown in 
the sample box at the current Size and 
Angle.

Use Load Stamp File  to load a .4qb file to use as a stamp. Load Stamp File opens the 
Open dialog box that shows thumbnails of .4qb files.

Create a Text Stamp
With Create a Text Stamp  you can use the TrueType® or OpenType® fonts on your 
computer to create a stamp with your selection of letters. Choose from Regular, Bold, Italic 
or Bold Italic styles, and adjust the font size in points. Enter the desired text and click OK. 
The text then appears in the preview in the Emboss tab. 

Create multi-line text by pressing ENTER while typing in the Text box.

Add a Name Below the Sweet Rose Embroidery
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In Documents\Premier+2\Samples\Modify\Stitch load the 'Girl with Rose Background' embroidery.
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Alternatively, you could use the embroidery you created in “Stamp the Background of the Sweet Rose 
Embroidery” on page 43.

4 Click Draw Next Color Block . The complete background is shown.
It is not necessary to isolate the visible stitches in the draw range, as no needle points will be removed.

5 Leaving the background unchanged, set Effect to Super.  
The Super effect creates a heavier impression as more needle 
points are removed surrounding the stamp.

6 Click Create a Text Stamp . The Create Text dialog box will 
appear.

7 In the left drop-down list, select Georgia as the font.
8 In the style (center) drop-down list, select Bold.
9 In the furthest right (font size) drop-down list, ensure that 

144 is selected.
The font size does not matter, as the stamp’s height can be changed before it is used.

10 Click inside the text box. The pointer changes to an I-bar .
11 In the text box, enter the words:

SWEET ROSE
12 Click OK. The stamp preview box now contains your text.
13 Click Single Stamp , then move the pointer over the work area. The 

pointer is now the text "SWEET ROSE".
14 The lettering is slightly too large to fit in the space at the bottom of the 

picture. Set the Size to 6mm.
15 Move the stamp so that the letter ’T’ is over the center grid line. Click 

to place the stamp.
16 Right-click to deselect your text stamp. Click Draw All Stitches .

Stamp Size
Set the stamp Size from 2 to 50mm in 1mm steps. To see how big a stamp will be, select 
Single Stamp and move the mouse pointer over your embroidery.

Stamp Angle
Rotate the stamps to any angle from 0 to 359 degrees. Use 
this to get the best result from a stamp, so that any straight 
lines in the stamp are at a different angle to threads in the 
embroidery. When you have parallel lines between the 
stamp and the threads, fewer stitch points will be placed and 
the stamp will be less noticeable.

The stamp sample to the right of the Size and Angle boxes 
shows how the stamp will look. Use Single Stamp to see how 
the stamp will be used on the embroidery and as a check against parallel lines.

Use Vertical Flip  to mirror the selected stamp from top to bottom. Use Horizontal 
Flip  to mirror the selected stamp from left to right.

Applying Stamps
The following methods are available to place stamps onto your embroidery. Only visible 
stitches are affected. Change the stamp, size and angle without deselecting .

0 degrees

45 degrees

Stamp
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Use Single Stamp  to place individual stamps. The mouse pointer will become the 
shape of the selected stamp when the mouse is over the work area. Use this to see how 
big the stamp will be on the embroidery. Click to place the stamp. Right-click to deselect. 

Use the Stamp Line  functions to create a line of stamps. Use Freehand Tablet Stamp 
Line  to draw a line of stamps in any direction. Click and drag to draw a line of stamps, 
preview the stamp outlines, adjust the nodes on the line, then right-click to place the line 
of stamps. Use Freehand Point Stamp Line  to place points for lines of stamps in any 
direction. Place points to preview the stamp outlines, adjust the nodes, then right-click to 
place the line of stamps.

Use Stamp Fill  to fill all visible stitches with the currently selected stamp. An animation 
will play while the Stamp Fill is being processed. The function is deselected automatically.

Stamp the Background of the Sweet Rose Embroidery
1 Click File, New  to open a new window, then in the Quick Access toolbar, click Insert .
2 Browse to the folder Documents\Premier+2\Samples\Modify\Stitch. Load the 'Girl with Rose' 

embroidery.
3 In the Control Strip, click Draw Next Color Block  once to show the color behind the girl’s head.
4 Click Ghost Mode . The stitches that were hidden are now shown in pale colors.
5 Move the Draw To End handle at the right of the slider bar to approximately stitch number 3114. This 

hides the background areas between the girl’s head and hair, and below her portrait.
Stitch numbers are given as guides only. It is more important to ensure that the correct stitches are hidden 
or left showing than to follow the exact stitch numbers. To adjust stitch by stitch, use the arrows.
Click in the space on the slider bar on either side of the handle to move it 
in that direction and change the stitch number by 50 at a time. You can 
also click and hold to change the number more rapidly, but the handle 
will stop when it reaches the arrow pointer.

6 Click the Emboss tab. Click Remove Needle Points in Fill . The stitches 
making the flat fill pattern will be removed.
It is recommended to use Remove Needle Points in Fill before stamping an 
area of stitches. This is so that the new pattern or series of stamps is clearly 
visible, rather than adding to an existing fill pattern.

7 Set Effect to Standard.
8 In the stamps area, select Plants in the Category drop-down menu.
9 Click the rose stamp (number 3) and it will be shown in the preview box 

for the stamps.
10 Click Single Stamp , then move the pointer over the work area. The 

pointer is now a rose.

11 Place the rose pointer over the area between the girl’s shoulders and 
hair.  The stamp is a little large to be used in this area; a smaller size 
would look better.

12 Set Size to 8mm and move the pointer back over the work area. The 
pointer is now smaller.
The pointer uses the size and angle that you choose in the Stamps area. 

13 Click Stamp Fill . The new stitch points are calculated, then the new 
fill pattern will be shown, giving a sculpted rose background behind 
the girl’s head and shoulders.

14 Click Draw All Stitches .
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9Editing Objects

Select Objects
In the Object window in PREMIER+™ 2 Modify, designs are made up of a sequence of lines 
and areas (e.g. stitch lines, fills and columns). Each area, line or column is defined by a 
number of points.

Select an Object to Edit
In the Object window move the pointer over the embroidery and you will see the points 
and outlines of the different areas. Click  inside a line or an area to select the object. 
The Edit Properties section of the Object tab will show what object type it is.

To select multiple areas, hold down the Ctrl key when selecting. It is often helpful to use Draw Previous 
Color Block  or Draw Next Color Block  to isolate areas for object editing.

After locating the desired object, click and drag its points to change the shape of the 
object. You can insert extra points  or delete unwanted points  in the selected 
object.

Alternatively, click the Properties button or right-click the object to access a dialog box to alter properties 
such as Fill Pattern or Stitch Length.

Edit Properties
The stitch type for the currently selected object is shown in the 
Edit Properties area.

If more than one object is selected, further stitch types can be seen in the stitch 
type drop-down list.
To change the properties for the selected stitch type, click the Properties  button, or 
select Properties from the right-click context menu. The Properties dialog box for the 
stitch type will appear.

Use Lighter Density  to make the stitches in the currently selected object(s) more open. 
When clicked, the density value is increased by 1.

Use Heavier Density  to make the stitches in the currently selected object(s) more 
closed. When clicked, the density value decreases by 1.

Select an object and stitch type

Edit the object’s properties

Make the stitching lighter or denser
Change the object’s stitch type

Remove stitches underneath the object

Align the origin handles for multiple selected fill areas

Show only the selected object

Add or remove points in an object outline

Add or remove a wave line 
from a MultiWave Fill area
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Convert
Use the Convert function to change the currently selected 
object to another stitch type.

Select the object that you want to convert, then click 
Convert  and select a new stitch type from the drop-down 
menu. The stitch type properties dialog box will appear. 

 If more than one object is selected, there may be more than one stitch 
type to convert from.
Select the desired properties and click OK to change the 
stitch type. 

Alternatively, right-click and select the stitch type to convert to from the context menu.

Stitch and Area Types
Stitch types in the following two groups may be changed to any other stitch type in either 
of these groups:

Lines

Areas

Columns
Objects in this group may be changed to any other stitch type in the group:

Any Column can be changed into a Satin Area, but it cannot be changed back.

Running Stitch Double Stitch Double Zigzag 

Triple Stitch Satin Line Motif Line 

Pattern Fill Motif Fill Shape Fill 

Radial Fill Spiral Fill QuiltStipple Fill 

Contour Fill Crosshatch Fill Curved Crosshatch Fill 

MultiWave Fill Echo Fill Satin Area 

Satin Column Feathered Satin 

Richelieu Bars Tapered Motifs 
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Area Types
Pattern Fill  areas 
contain small stitches 
with repeating 
patterns, which can be 
selected from the 
system fill patterns.

Contour Fill  areas 
use contour stitch 
lines. Vary the gap 
between stitch lines 
and the length of the 
stitches, use running, 
double or triple stitch.

Shape Fill  areas use 
one of 75 different 
shapes. Vary the stitch 
density, use running 
stitch or motif lines for 
the fill.

Radial Fill  areas use a 
pattern of radiating lines 
from an origin point that 
can be moved. Vary the 
stitch density.

Spiral Fill  areas use 
a spiral pattern from an 
origin point that can 
be moved. Use 
constant or gradient 
density.

QuiltStipple Fill  
areas use stipple stitch 
in curved or straight 
lines. Vary the gap 
between stitch lines, 
use running or triple 
stitch.

Motif Fill  areas 
contain repeated small 
stitches using one of the 
Universal or machine 
motif patterns. The 
motifs can be at any 
angle and at different 
sizes, and can be varied 
on alternating lines.

Crosshatch Fill  areas 
use diamond, square and 
parallel crosshatch 
patterns, or select the 
angles. Set the gap, style, 
line angle, stitch type and 
stitch length.

MultiWave Fill  
areas use a wave 
pattern defined by a 
line, or lines, drawn on 
the fill area. Vary the 
density, or use a motif 
for the stitch lines.

Echo Fill  areas use 
echo lines within or 
around a shape. Use 
rounded, square and 
diagonal corners, and 
set the gap between 
the echo lines.

Curved Crosshatch 

Fill  areas use a mesh 
of curving lines. Vary the 
curve and the gap 
between the lines, and 
use running, double, 
triple or motif lines.
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Satin Areas
Satin Areas  contain zigzag stitches that fill the area from one end 
to the other at the same density. The stitch angle changes with the 
shape of the area, and can be adjusted as desired. Choose automatic 
edge walk and/or zigzag underlay.

Convert Satin Areas into any type of fill area.

Satin Column
Use Satin Column  to create a straight or curved column of parallel 
stitches. The column may be of any length.

The recommended maximum length for satin stitches is around 8-10mm. 

Feathered Satin
For lifelike realistic feathers or fur, use Feathered Satin , where the 
start and end points of the stitches are random rather than all parallel. 
Feathered satin may also be created with only one side feathered – the 
side where the first (A) or second (B) point was placed.

Richelieu Bars
Use Richelieu bars  to create a column of short sections of satin 
perpendicular to the direction of the column. Choose the number of bars, 
and the width of the satin.

Richelieu bars are typically used for cutwork designs.

Tapered Motifs
Use Tapered motifs  to create a line of motifs that vary in size according 
to the width of the column.

Tapered motifs are often used in lace designs.

Feathered Both Feathered Side A Feathered Side B
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Running, Double and Triple Stitches
Set Running Stitch  from 0.3-12mm. Set Double , Double Zigzag  and Triple  
stitch to any length from 1mm to 12mm.

Running may also be set to cutwork needles.
Double Zigzag is a special stitch type, recommended for lace. A running stitch line is retraced in a zigzag 
pattern to create a mesh.

Motif Line
Motif lines  are lines of the chosen Universal or machine motif 
patterns.

Satin Line
Create Satin lines  where a line or border of satin stitches of 
constant width is desired. The line will be created along the center 
of the chosen line.

Single Stitch
Single stitches are embroidered at whatever length they are 
created. Alternatively, if you select to Break Up into Smaller 
Stitches they will be broken up into stitches of Running 
Stitch at any length from 1mm to 12mm.

Single stitches cannot be converted to any other line type.

Edit Lines and Areas
The shape of a line or area can be changed in the Object 
window by moving the points that define its outline.

Move the pointer until the desired area is highlighted 
then click to select it on the work area. When the desired 
line or area is selected, its points can be moved. The 
points are shown as small circles or squares.

Square points are used for straight sections and corners. Round 
points are used for curves.
Objects such as fill areas, running stitch and satin lines, 
can have any number of points, and points may be inserted and deleted, allowing greater 
control over their shapes. The start and end points for fill and satin areas can be changed, 

Running Double Triple
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typically to reduce the need for trimming. Satin areas have angle lines that are used to 
control the satin angle.

Move Points
The points that define the currently selected stitch object (satin column, fill area, running 
stitch, etc.) are shown as small squares and circles.

The object type is shown in the Edit Properties area of the Object tab. The points used to 
start and end fill and satin areas are shown by the start  and end  markers. Some 
types of fill areas also have an origin, marked by an orange circle , or for Pattern Fill an 
orange cricle with a handle . Satin areas also have stitch angle lines with hexagonal 
ends.

Once the points are shown, click and drag the squares or circles to move them. The first 
point is shared with the previous object, and last point is shared with the next object, so 
moving these will also change the shape of those objects.

When a different point is selected for the start or end of a fill or satin area, a movement 
stitch (trim) may be added to prevent the previous or next object changing shape.

Moving the points that define a satin area may also affect the stitch angle lines, but moving the stitch 
angle lines does not affect the shape of a satin area.

Make Lines Straight or Curved
The outlines defining most types of lines and areas can have both curved and straight 
sections:

To have any curves, lines must be defined by at least four points. The first point of a fill or 
satin area is always a 'corner' (square) point. The first and last pair of points for a column 
are always square.

To change a curve (round) point to a square point, hold down the Ctrl key and click the 
point without moving it. When adjacent points are corners, the line between them will be 

Fill areas have as many points as needed to define 
their outlines, and also have moveable start, end 
and origin markers

Satin areas have moveable start and end 
markers and adjustable stitch angle lines

Start
Marker

Origin
Marker

End
Marker

Start
Marker

End Marker

Stitch Angle
Lines
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straight. This is useful if, for instance, a point was not added as a corner at the desired 
place on a fill area or stitch line.

To change a corner point to a curve (round) point, simply click the point without moving 
it. There must be at least two round points next to each other to make the lines curved, so 
if there is one round point between two square points then the lines to the round point 
will be straight.

If a line does not have enough points to make the desired section curved, use Insert Points  to add an 
extra point to use for the curve.

Move the Start and End Points for Areas
The start and end points for fill and satin areas are shown by circular markers. The start 
marker  is on the inside of the object, and the end marker  is on the outside of the 
object.

Click and drag the desired marker. Move the marker to the point that you wish to use as 
the new start or end point of the area. Drop at the desired point and the position of the 
marker will change.

The marker snaps to the nearest point on the edge of the object. If an area does not have a point in the 

desired position, use Insert Points  to add an extra point.

Move the Origin for Areas
Some types of fill areas have an origin, marked by a orange circle . This is used to move 
the center point for Radial fill, Spiral fill and Shape fill types, or the start point for the 
pattern in a Pattern Fill.  For Pattern Fill, the origin marker also has an adjustment handle to 
set the angle of the pattern .

This means you can control how the pattern is repeated in a pattern fill area.
For Radial fill, Spiral fill and Shape fill areas, the origin can be moved. This sets the start 
point for the fill, such as the point from which stitches radiate on a Radial fill.

Use Align Origin Handles  to align the origin for multiple fill areas.

Change the Stitch Angle for Satin Areas
Satin areas have stitch angle lines that show and adjust the angle of the stitches across the 
area. The stitch angle lines have pink handles at each end that are used to adjust each line 
individually.

Point is a curve Point is a corner after Ctrl + click
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Click and drag the desired pink handle. Drop at the desired point and the position of the 
angle line will change. If the line does not move, this is because the new end point is not 
usable. This will happen if, for example, you attempt to force two angle lines to cross each 
other within the area.

To delete angle lines, click Delete Points  then click the hexagon at either end of the 
line to be deleted. Right-click when you have finished deleting angle lines and/or points.

A satin area must have at least one angle line. Therefore, the last angle line may not be deleted.

Insert Points
Use Insert Points  to add a new point to the currently selected line.

Points may be inserted into all line and area types. They may also be inserted into MultiWave lines.
Click the Insert Points icon , then click the position on the selected object where you 
want to add the point.

A pair of points is inserted when Insert Points is used on a column.

Delete Points
Use Delete Points  to delete points from the currently selected line. 

Points may be deleted from all line and area types. Points may also be deleted from MultiWave lines.
Click the Delete Points icon , then click the points on the selected object that you want 
to delete. Stitch angle lines can be removed from satin areas by clicking the hexagonal 
control point at either end of the line. Right-click to finish.

You may not delete all the points for an object. A fill or satin area must have at least three points. Satin 
border, motif lines and running, double and triple stitch lines must have at least two points. A satin area 
must also have at least one angle line.

MultiWave Lines
Use Freehand Tablet MultiWave Line  to draw a line that shapes the wave patterns in a 
MultiWave Fill.

Use a long line to position the stitch lines in an embroidery, or use a short line to add texture to the 
stitching. The lines do not have to be within the fill area, however they should not cross each other. Vary the 
density or use a motif to change the effect.

MultiWave Fill areas, using two MultiWave Lines to 
shape the flow of the fill within the wings.

MultiWave Fill, using a short MultiWave 
Line to add texture to an embroidery
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Use Freehand Point MultiWave Line  to place points to form a line that shapes the wave 
patterns in a MultiWave Fill.

Delete MultiWave Line
Use Delete MultiWave Line  to delete one or more MultiWave lines from the currently 
selected MultiWave Fill area. Click the square (node point) at either end of the line to be 
deleted. Right-click when you have finished deleting MultiWave lines.

Modify Object
Remove Underlying Stitches
Use Remove Underlying Stitches  to remove all visible stitches within the area of the 
selected object, excluding stitches in the object itself, and those stitched out after it. Use 
Remove Underlying Stitches to remove the packing stitches under a fill before converting 
it to a lightly stitched fill such as MultiWave Fill. 

Align Origin Handles
Use Align Origin Handles  to align the patterns or focal points of multiple fill areas. It 
places the orange origin  handles of the fill areas in the same position as the handle of 
the object that is last in the stitching order.

Align Origin Handles is useful when aligning fill patterns for Pattern Fill or focal points for Shape, Radial 
and Spiral Fill.

Align the Stitching in Bumblebee Wings
1 Click File, New  to open a new window.
2 In the Quick Access toolbar, click Insert .
3 In the folder Documents\Premier+2\Samples\Modify\Stitch load the 'Bumblebee 2' embroidery.
4 Click the Object tab. The pointer changes to the Object Select pointer.
5 Move the pointer until the upper wing is highlighted, then click to select it.
6 In the Modify Object area, Click Remove Underlying Stitches .
7 Then click the lower wing to select it and click Remove Underlying 

Stitches.
Remove Underlying Stitches removes any underlay stitches, or other 
stitches, under a fill area. This will enable you to see the stitch lines in the 
Spiral Fill you are about to create clearly.

8 Select the upper wing, then use Ctrl + click to select the lower wing.
9 In the Convert drop-down list, select "Pattern Fill to Spiral Fill". The Spiral 

Fill properties dialog box appears.
10 In the Options tab, set Density to 15 and click OK. The bumblebee’s 

wings now use spiral fill.
11 Click Align Origin Handles to align the origin handles for the selected areas.
12 Move the orange origin handle   above the lower wing. The spiral pattern for both areas follows 

the origin point.

Show Only Object
Use Show Only Object  to move the handles on the slider bar so that only the selected 
object can be seen.
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10Getting Started with 
PREMIER+™ 2 Cross Stitcher
Welcome to PREMIER+™ 2 Cross Stitcher. PREMIER+™ 2 Cross Stitcher helps you create 
beautiful cross stitch designs to embroider on your machine. Cross types include full 
crosses, half crosses, quarter crosses, half height crosses, half width crosses and mini 
crosses.

Place outlines of standard and freehand backstitch, and use French knots for the perfect 
accent. Design traditional cross stitch motifs on the screen or use the Cross Stitch Design 
Wizard to produce designs automatically from clipart, drawings and photos.

Flood fill areas with crosses of any color. Alternatively, choose a ready made cross stitch or 
blackwork pattern. Create your own fill patterns, too. Reflect your design up to eight times 
automatically with the amazing Multiply feature. Draw shapes in different outline and fill 
styles. Place text with TrueType® or specially designed fixed fonts.

Sample Files
Samples are included that are shown in the ’How-To’ examples and tutorials. The sample 
files will be installed to subfolders of Documents\Premier+2\Samples\Cross or the folder 
of your choice.

Starting PREMIER+™ 2 Cross Stitcher
 In PREMIER+™ 2 Embroidery, click the PREMIER+™ 2 Cross Stitcher icon  on the 

QuickLink toolbar. PREMIER+™ 2 Cross Stitcher will start.

Parts of the Software Window
The title bar at the top of the window is highlighted if PREMIER+™ 2 Cross Stitcher is active. 

The Quick Access toolbar gives icons for the following frequently used features: Insert, 
Save, Save As, Export, Print, Undo, Redo, Life View and Design Player. If more than one 
instance of PREMIER+™ 2 Cross Stitcher is open, each open window will show the name of 
the cross stitch design file.

There are 8 tabs on the ribbon bar: File, Home, Create, Multiply, Letter, Pattern, View and 
Help.

Cut, copy, paste or delete selected stitches

Use a selection tool to select stitches View the design as it will be when stitched out

Rotate the selected stitches
View and hide crosses, backstitch & knots

Remove colors not used in the design
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An alternative way to access ribbon options is to press the Alt key, then the highlighted letter of the tab, 
followed by the highlighted letter of the tab item, e.g. Alt, H, U to remove unused colors in the design. Some 
functions are available by pressing the Ctrl key and another key at the same time. These shortcuts are 
shown in the tooltip for the relevant function.
Use the Home tab to select, copy, move and rotate parts of a design; to view and hide 
crosses, backstitch and knots, and to display the design with Life View and Design Player.

Use the Create tab to draw and erase crosses, backstitch and French Knots, to flood fill 
areas with crosses or a pattern, and to draw shapes.

Use the Multiply tab to repeat stitch placement or edit actions automatically by reflecting 
across, down or rotating. 

Use the Letter tab to add lettering using Fixed or TrueType fonts. Create new fonts from 
most TrueType® or OpenType® fonts on your computer.

Use the Pattern tab to choose fill patterns for use with shapes and lettering, and to create 
new patterns from a small stitch design.

Use the View tab to  adjust the Grid, measure a design, show and hide the background 
picture, and change the view mode.

The design area is the area within the work area where stitches can be placed and edited. 
Use View Mode to switch between 3D , 2D  and Block  stitch views. When the Grid 
is on, the design area shows grid lines with uniform spacing. Each grid square corresponds 
to one cross in the design. If there is a background picture, this is only shown within the 
design area.

To the right of the work area is the design panel. The Design Information shows the 
dimensions (Height  and Width ), Stitch Count , and number of colors  for the 
active design.

Title BarQuick Access Toolbar Ribbon Bar Tabs

Status Bar Design Area Design Panel

Ribbon Bar
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Thread colors can be added as desired or added automatically. Use the Move and Merge 
color buttons to change the thread order. Use the Notes box to enter details about the 
design.

PREMIER+™ 2 Cross Stitcher Terms and 
Conventions
On-screen Pointers
The pointer is most commonly shown as an arrow  on the screen.

If it is positioned over a text box it changes to an I-bar  and you can type, such as the 
Letters box on the Letter tab. If Zoom To Rectangle  is chosen, the zoom in pointer  
appears. When zoomed in if the Pan feature is used to move around the screen, the Pan 
pointer  appears. The Box Select , Freehand Select , or Freehand Point Select  
pointer appears when the associated Select function is chosen. When the pointer is over a 
selection, the four arrow pointer appears , showing that the selection can be moved.

When the drawing functions on the Create tab are chosen, the pointer appears as follows:

The drawing pointers are red when set to Erase.
When Pick Color is used to choose a color in the Design Area, or used to choose additional 
colors on the Thread Colors page of the Cross Stitch Design Wizard, the Pick Color 
pointer  appears. The measure pointer  appears when Get Length is chosen.

File Formats

Cross Stitch Design Files
PREMIER+™ 2 Cross Stitcher loads and stores cross stitch design files with the extension 
.krz.

Picture Files
PREMIER+™ 2 Cross Stitcher can load any of the following picture file formats: Windows or 
OS2 Bitmap (.bmp), JPEG-JFIF Compliant (.jpg, .jif, .jpeg), Portable Network Graphics (.png), 
Tagged Image File Format uncompressed (.tiff, .tif ), Windows Meta File (.wmf), Windows 
Enhanced Meta File (.emf) and Windows Icon (.ico).

Embroidery Files
PREMIER+™ 2 Cross Stitcher can export embroidery files in any of the following formats: 
Brother/Babylock/Bernina PEC (.pec), Brother/Babylock/Bernina PES (.pes version 2 - 10), 
Compucon/Singer PSW (.xxx), Husqvarna Viking / Pfaff (.vp4, .vp3 and .vip), Husqvarna 
(.hus ,.shv), Janome (.jef and .sew), Melco (.exp), Pfaff (.pcs), Tajima (.dst) and Toyota (.10*).

Full Cross Quarter Cross Half Cross 
Forward

Half Cross 
Backward

Mini Cross Half Width 
Cross

Half Height Cross Standard 
Backstitch

Freehand 
Backstitch

French Knot Flood Fill
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Note: The preferred file format for exporting embroideries is .vp4, as this will preserve thread color 
information and notes.

Hints on Planning Cross Stitch Designs
Design Size
The Design Area is determined by the Width x Cross Size and Height x Cross Size. It is 
shown on the Design Size page of the Cross Stitch Design Wizard and in Design Properties.

The Width and Height in the design Information in the Design panel gives the size of the 
actual embroidery that will be created from the current cross stitch design.

If there are French knots at the edges of a design, the embroidery Width and Height may be greater than 
the Design Size.

Flood Fill
When an area is flood filled, the fill does not relate to the background picture. An empty 
area can be flood filled until it meets existing crosses and/or backstitch. A connected area 
of the same colored crosses can be flood filled until it meets an empty area, backstitch or 
crosses in a different color.

Sometimes it may help to hide the background picture so that you can clearly see the area 
you wish to flood fill; for example, if there are lines in the background picture that are 
similar to backstitch.

Stitch Layers and Movement Stitches in the Embroidery
When you create an embroidery from a cross stitch design, PREMIER+™ 2 Cross Stitcher 
generates crosses in the color order in the palette. Then the palette order is repeated for 
backstitch and French knots.

If there are backstitch and French knots in the same color, the backstitch is stitched out 
and then the French knots, all as a single color block. To ensure French knots are stitched 
after a different backstitch color, use the Color Select area to change the order of thread 
colors in the palette.

Crosses and Movement Stitches
Movement stitches are automatically placed between each color area, and between 
crosses of the same color if they are not connected. Minimize movement stitches, and 
therefore the trims required after embroidery, by linking crosses of a color to at least one 
other cross in that color.

For a neat finish to your cross stitch embroideries, trim the movement stitches before each color change.

Standard Backstitch and Freehand Backstitch
Standard Backstitch  is drawn in short sections that snap to the 
sides and diagonals of grid squares. This means the end points for 
Standard Backstitch are the corners of the grid squares.
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Freehand Backstitch  is drawn as a separate layer to Standard 
Backstitch. Freehand Backstitch is placed using end points that 
snap to half grid spacing anywhere on the design. This means that 
a single section of Freehand Backstitch can be any length that will 
fit within the design.

Although the screen shows Standard Backstitch and Freehand Backstitch as separate 
layers, they are stitched out together when they are the same color. There will be 
movement stitches between sections of backstitch if they do not connect at an end point. 
Freehand Backstitch will not join to other backstitch without a movement stitch if it simply 
crosses over without the end points connecting. To reduce movement stitches, place 
Freehand Backstitch so that the end points connect to Standard Backstitch sections or 
other Freehand Backstitch sections.

It is possible to place Freehand Backstitch directly on top of Standard Backstitch and both sections will be 
stitched. This can be used for special effects, such as thickening a line without having to change the 

number of threads in Color Properties .

French Knots and Movement Stitches
French knots are stitched individually. They are not connected to other stitches. Therefore, 
there are movement stitches to and from all French knots. Use French knots to add 
decorative details to your designs.

Stitch Counts
The number of stitches shown in the Design panel and printouts is an approximation and 
may not match the number of stitches shown when the embroidery is copied or loaded 
into other PREMIER+™ 2 Embroidery System modules.

Printing a Worksheet
Use the print options on the File menu or the Print icon  to print a worksheet for the 
embroidery created from the design.

Information for Hand Cross Stitchers
Many effects from hand cross stitch are possible with PREMIER+™ 2 Cross Stitcher. Change 
the cross size, alter the number of threads and choose different stitch types to create many 
different styles.

Cross Size
Varying the cross size (in Design Properties) produces a wide range of embroidery results. 
For example, small cross sizes, such as 1.4mm resemble petit point. Larger cross sizes, such 
as 1.8mm or 2mm are closer to traditional gros point or cross stitch. To create cross stitch 
designs at the same sizes as real counted fabrics, set the Cross Size as shown:

Aida Count Cross Size Aida Count Cross Size Aida Count Cross Size

11 2.3mm (0.091") 16 (also 32 on Linen) 1.6mm (0.063") 22 1.2mm (0.047")

14 1.8mm (0.071") 18 1.4mm (0.055")
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Thread Count
Altering the number of threads (in Design Properties and Color Properties ) also has an 
effect. For example, single thread allows the crosses to be seen more clearly. Double or 
triple thread produces embroidery looking more like 'tapestry' or needlepoint. The 
number of threads may also be varied depending on the cross size — a small cross size 
such as 1.4mm often stitches out best using single thread. Cross sizes of 1.6mm, 1.8mm or 
2.0mm are often effective with double thread. Designs with larger cross size may benefit 
from triple thread, especially for backstitch threads.

Stitch Types
A number of different stitches are used in PREMIER+™ 2 Cross Stitcher. A Full Cross is 
similar to a full cross in hand work, and can be placed as part crosses in quarters and 
halves.

Small stitches are available as half width, half height and mini crosses.

Use Standard Backstitch   and Freehand Backstitch  to create outlines. Also place 
French knots  in any of nine grid positions for decorative details.

Color Combinations
Certain adaptations to hand cross stitch techniques will produce machine embroidery 
files that are easier to stitch. For example, combine colors when possible to reduce the 
number of thread changes required. Always try to link crosses of a color to at least one 
other cross in that color. This will avoid movement stitches that have to be trimmed after 
embroidery.

Multiply
Use Multiply to repeat stitch placement or edit actions automatically by reflecting across, 
down or rotating. Symmetrical designs can be created quickly and easily. All changes in 
the design, such as adding and removing stitches, pasting selections and inserting 
designs, are multiplied.

The selection tools may not be used to make new selections when the Multiply function is active. However, 
you may use them before activating Multiply to select and copy a selection, which can then be pasted and 
multiplied.

Full Cross Quarter Cross Half Cross Forward Half Cross Backward 

Mini Cross Half Height Cross Half Width Cross 
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Choose any combination of Reflect Across, Reflect Down or Rotate to repeat actions. The 
previews show how actions will be repeated according to the current selection. Click Use 
Multiply  to turn Multiply on and off. The blue Multiply reflection lines are shown on 
the work area when Multiply is switched on.

Design Styles
Use PREMIER+™ 2 Cross Stitcher to create traditional cross stitch & other embroidery 
styles.

Eastern European Cross Stitch
One and two-color cross stitch designs, often in red and black or orange and black, are 
popular in peasant embroidery in Russia, Romania, and many other countries of Eastern 
Europe. These may be produced using PREMIER+™ 2 Cross Stitcher.

Assisi Work
This traditional hand cross style named after the town of Assisi in Italy may be reproduced 
using PREMIER+™ 2 Cross Stitcher. The design is outlined in black, using double or triple 
threads. 

Use Reflect Across to reflect horizontally. Use Reflect Down to reflect vertically.

Combine Reflect Across and Reflect Down to create 
four copies around the Multiply center point.

Use Rotate to create four rotated copies around 
the Multiply center point.

Combine Rotate with Reflect Across or Reflect 
Down to create eight copies. Additional blue 
lines show the eight segments.
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This outline stitch is sometimes called Holbein stitch. 
The background of the design is worked in single 
thread cross stitch in a strong color, traditionally 
china blue, but red may also be used. Full Crosses 
should be used, with no partial crosses or any of the 
smaller cross types. A 'reverse' or 'relief' effect is 
therefore achieved. 1.8mm is a suitable cross size to 
use for this type of embroidery. This type of cross 
stitch is traditionally done on fairly loose weave linen 
or cotton fabric, although it looks equally good on 
other fabrics. Simple shapes are most suited to this 
style of cross stitch.

Blackwork and Redwork
These are backstitch-only styles, generally using only black or 
red thread. Traditional patterned shapes in backstitch are used 
to fill areas of the design instead of using conventional crosses. 
A number of fill patterns are provided that can be used for this 
style of embroidery. Switch between blackwork and redwork fill 
simply by changing the color on a fill pattern.

Designs created only in backstitch are often called blackwork. 
They often use a single color (blackwork or redwork; blackwork 
was popular in Elizabethan England; redwork is well known in 
North American folk quilts). PREMIER+™ 2 Cross Stitcher 
includes many beautiful blackwork fill patterns.

Gobelin
Gobelin is placed as parallel vertical or slanted stitches of equal 
length, and is used to fill areas with a simple stitch pattern. In 
PREMIER+™ 2 Cross Stitcher, use Half Forward or Half Backward 
Crosses for gobelin slanted at 45 degrees, or use Freehand 
Backstitch for vertical or near-vertical gobelin stitch.

Rice Stitch
Rice stitch is a normal cross with a small stitch across each arm 
of the cross. This gives the appearance of overlapping crosses. To produce 
this effect, use a large cross size for the design and place the small stitches 
across the arms with Freehand Backstitch, often in a different color to the 
main cross.

Lace
Use blackwork to create simulated lace resembling heritage styles such as Tenerife lace, 
Hardanger or Filet-Guipure. Create outlines with backstitch, then fill with blackwork 
patterns. Stitch the designs on light net fabric (similar to that used for bridal veils) with a 
heavy water-soluble stabilizer. Then wash the fabric to remove the stabilizer.
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11Using the Cross Stitch Design 
Wizard
Use the Cross Stitch Design Wizard to convert pictures automatically to crosses. Also use 
the Cross Stitch Design Wizard to load a picture as a background only, load an existing 
cross stitch design or start a new design with no picture.

The Cross Stitch Design Wizard is started by New and also when PREMIER+™ 2 Cross 
Stitcher is started.

Hints and Tips on QuickCross Designs
Use Different Thread Ranges
Choose different Thread Ranges and numbers of colors to see the effect of different 
selections. For instance, neon thread ranges give 'pop art' effects.

Enhance Eye Highlights
When converting a portrait, use Pick Color on the Thread Colors page to select the 
highlights in the eyes. This will brighten the eyes and enhance the converted picture.

Remove Isolated Crosses
After the design is created, check for isolated crosses. If an isolated cross is not important 
for detail, replace it with the surrounding color, or a connected color. This will reduce the 
number of movement stitches in the finished embroidery.

Reduce Color Changes
Reduce the number of colors in the design. To do this, choose a color you wish to keep and 
then flood fill or paint full crosses over similar colors until only the chosen colors remain. 
Alternatively, use Merge Colors  in the Color Select area of the Design panel to change 
all crosses of one color to another color. It is recommended to do this one color at a time, 
so you can see the effect of replacing each color. When you reduce the number of colors 
this way, the effect is different from deleting colors in the Cross Stitch Design Wizard.

Color Order
Use the Color Select area of the Design panel to change the color order so that the design 
stitches from the inside out. This helps to reduce the effect of pulling on the fabric.

Add Borders
Add a simple border of backstitch along the edges of the design. Use a contrasting color 
to make the border stand out.

Add a more elaborate border by increasing the design size by a few squares, then flood fill 
with crosses or a pattern in the blank squares around the edge. You will need to convert 
the picture at a size that will allow the design and a border to fit inside the desired hoop.
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Note that when you change the design size, the background picture will be removed. Save the design first 
so you have a copy of the design with the background picture, then use a new name for the design with a 
border.

How to Use the Cross Stitch Design Wizard
Create a Cross Stitch from a Photograph

1 Click New  and the Start Page of the Cross Stitch Design Wizard appears.

Create QuickCross Design Load Picture for New Cross Stitch Design

Create a new design by converting color 
areas in a picture to crosses. Select the 
maximum number of colors and the desired 
thread range to use for the cross colors.

Create a new design by loading a picture, cropping or 
straightening as desired. Set the cross size and design 
area. The picture is loaded into PREMIER+™ 2 Cross 
Stitcher.

Load Existing Cross Stitch Design Start a New Cross Stitch Design with no Picture

Open an existing cross stitch design to 
preview it in the wizard, then close the 
wizard and load the design in PREMIER+™ 2 
Cross Stitcher. The design area and palette 
are set according to the design loaded.

Select the desired cross size and design area, then 
close the Cross Stitch Design Wizard and start with a 
blank work area. 
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2 Leave Create QuickCross Design 
selected and click Next. The 
Choose Picture page of the 
Cross Stitch Design Wizard 
appears.

3 Click Load a Picture  and the 
Picture Viewer dialog box 
appears.

4 Browse to the folder 
Documents\Premier+2 \Samples 
\Cross\Pics, click the file named 
'Linnet.jpg' and click OK. The 
picture will be previewed in the 
wizard.

5 Click Next and the Rotate and 
Crop Picture page appears.

6 Initially, the whole picture is 
selected. In the picture area, 
move the pointer to the handle 
at the top right of the picture. 
Click and drag the handle to 
make the crop box smaller. 
Move the right side of the crop 
box until it is half way across the 
ear on the right, then release the 
mouse button or lift the pen.

7 Click and drag the handle on the 
top left until the line is half way 
across the ear on the left.

8 Click and drag the handle at the 
bottom right and move it 
upwards until it touches the 
button just under the girl’s chin.

9 Click and drag the center handle 
at the top right and move it downwards until the crop box is square.

10 Click Next. The Design Size page 
appears.

11 Change the Cross Size to 1.4mm.
Smaller cross sizes, such as this 
which is equivalent to Aida 18 
count, provide greater detail when 
creating cross stitch designs from 
photographs.

12 Click Select Hoop and the Hoop 
Selection dialog box appears. 
Ensure the Hoop Group is set to 
Universal, then set the Hoop Size 
to 100mm x 100mm - Universal 
Square Hoop 1. Click OK and the 
new design area will be 
calculated and previewed.

13 Click Next and the Choose Thread 
Colors page appears, showing only the cropped area of the picture.
The original picture is not affected by the Cross Stitch Design Wizard.

14 Select Robison-Anton Rayon 40 as the Thread Range.
15 Set the Number Of Colors to 20 and click Apply. The thread choice is automatically calculated.
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16 Notice that the thread selection 
from Robison-Anton Rayon 40 
has mainly brown tones for this 
picture. Click the drop-down 
arrow for the Thread Range and 
choose Sulky Rayon 40 instead.

17 Set the Number Of Colors to 20 
and click Apply again.
The Thread Range can be changed 
as often as desired.
The Cross Colors preview and 
thread color list may differ from the 
result shown. This is because even 
slight differences to the selected 
crop area will give different results 
in the cross stitch design.

18 Click Next. The Preview page 
appears.
This shows you the embroidery as it will be stitched out, giving information on the dimensions, the number 
of stitches, and the number of colors.

19 Click Finish. The cross stitch design will be created and then displayed on the screen. Any duplicate 
colors will be automatically combined into single colors in the color worksheet.

20 Click the Create tab, then click the Color block at the left of the tab.
21 In the pop-up palette, click Add Color  and the Color Selection dialog box will appear so you can 

choose a new color.
22 Select Sulky Rayon 40 as the Thread Range.
23 Click the yellow Quick Color, and the thread list will jump to 1124 (Sun Yellow).
24 This color is rather bright, so click the paler yellow 1061 above it in the list (1061 Pale Yellow).
25 Click OK. The new color is added to the palette 

and is automatically selected.
26 Click the Cross Flood Fill icon  and the pointer 

changes to the paint bucket .
27 Click the solid background areas on the left and 

right.
If desired, also fill any individual colored crosses 
along the edges of the background where it meets 
the sweater and the girl’s hair. This will reduce the 
number of movement stitches in the finished 
embroidery.

28 Move the slider in the zoom bar to 100% to view 
the design at the size it will be stitched.

29 In the Home tab, click Design Properties. In the 
Design Properties dialog box ensure Thread 
Count, Crosses is set to Single (2 Threads). Click 
OK.

30 Cllck Edit Notes  and in the Notes dialog box 
type 'Family Photo'. Click OK.

31 In the Quick Access toolbar, click Save As  and the Save As dialog box appears.
32 In the Save In box, browse to the folder Documents\Premier+2\My Designs. In the File Name box, 

leave the name as 'Linnet', as set by the picture name. Click Save.
This will save your design as a cross stitch design (.krz) file.

33 In the Quick Access toolbar, click Export  and the Export dialog box appears.
34 In the File Format drop-down list, ensure .vp4 is selected. 
35 Click OK. The Save As dialog box appears to save the embroidery.
36 In the Save In box, browse to the folder Documents\Premier+2\My Designs. In the File Name box, 

ensure the name is 'LinnetExported', then click Export.
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12Creating Stitches and Shapes

Draw stitches of the chosen type and color in the design area. The pointer shows which 
stitch type is selected, and the Thread Color shows the drawing color.

Pop-up Palette

Use Erase  to erase stitches of the selected type. It can then be used to erase stitches 
when a stitch drawing function is selected. 

Crosses
There are four types of crosses:

 A Full Cross fills a whole grid square. Parts of a full cross (Quarter Cross, Half Cross Forward 
and Half Cross Backward) can be placed or removed for quarter, half and three-quarter 
crosses.

 A Half Height Cross is a cross in the top or bottom half of a grid square.
 A Half Width Cross is a cross in the left or right half of a grid square.
 A Mini Cross is a small cross in any corner of a grid square.

When drawing crosses, any type of cross can replace all or part of any other type of cross. 
The size of the currently selected cross type determines how much of a grid square will be 
replaced or erased.

Backstitch and French knots are not affected by drawing and erasing crosses.

Draw Full, Half or Quarter Crosses

Choose a thread color for drawing
Erase stitches of the selected type

Draw Backstitch or French Knots
Draw a cross or pattern flood fill area

Select No Fill, Cross Fill or Pattern Fill
Select No Outline, Backstitch Outline or Cross Outline

Select a shape & draw it in the work area

Smooth the shape

Draw a Tablet or Point shape

Click to open the pop-up palette

Add a color to the pop-up palette from the Color Selection dialog
Pick a color from the background picture or the design

Click a color to select it for drawing
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Backstitch and French Knots
There are two types of backstitch in PREMIER+™ 2 Cross Stitcher: Standard  and 
Freehand . Standard Backstitch  is drawn in short sections that snap to the sides and 
diagonals of grid squares. The end points for Standard Backstitch are the corners of the 
grid squares. Freehand Backstitch  is drawn as a separate layer to Standard Backstitch. 
Freehand Backstitch is placed using end points that snap to half grid spacing anywhere on 
the design. A single section of Freehand Backstitch can be any length that will fit within 
the design.

Use French Knot  to place  French knots that snap to half grid spacing. Each French 
knot is placed or erased with a single click.

Cross and Pattern Flood Fill
Use Cross Flood Fill   or Pattern Flood Fill  to fill  an area with crosses or a fill 
pattern. An empty area can be flood filled until it meets existing crosses and/or backstitch. 
A connected area of the same colored crosses can be flood filled until it meets an empty 
area, backstitch or crosses in a different color. Crosses are not considered to be connected 
for flood fill if they only meet at a corner.

Drawing Shapes
Draw one of 75 shapes with Place Shape , or draw an area or outline of any shape with 
Freehand Tablet Shape  and Freehand Point Shape .

Create a Shape
1 In the Shape section of the Create tab select a fill and 

outline type. 
2 If drawing a shape with a Backstitch Outline , you 

may select Smooth to smooth the outline of the 
shape by using three-quarter crosses rather than full 
crosses.
Cross Outline  is not affected by Smooth.

3 Click the thread colors for your Fill and Outline 
choices to select a color for Cross Fill and your 
outline.

4 To change the colors or pattern for a Pattern Fill , choose the pattern and its colors in the Pattern 
tab.  See “Select a Pattern” on page 75.
If a color is chosen that does not exist in the palette, it is automatically added to the palette when a shape 
is drawn in that color.

5 Choose a shape from the Shape drop-down menu.
6 Click the Place Shape  button to place the shape in the work area.

The outline and fill will use the chosen colors and stitch type.
7 Drag the shape to the preferred position, and resize it as desired using the 

square corner handles.
Hold down Ctrl as you drag to resize proportionally. Hold down the Shift key 
to resize from the center.

8 Right-click the shape to place it in the work area.
9 If desired, draw another shape or use Undo and draw the shape again.
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Draw Shape
Use the Draw Shape  options Freehand Tablet Shape  and Freehand Point Shape  
to draw an area or outline of any shape. Use Freehand Tablet Shape  to draw a line to 
create shape. Draw a line, and the line is closed automatically to form a shape. Adjust the 
shape by moving the nodes. Use Freehand Point Shape  to create a shape by placing 
points to create an irregular outline of curved and straight lines around the desired area.

Shape Options
Use a Cross Fill  to draw an area filled with crosses, or a Pattern Fill  to draw an area 
filled with a selected pattern. Use No Fill  to create an outline only.

Click the Fill color thread sample and choose a color from the drop-down menu. Use Add 
Color  to select a color in the Color Selection dialog, or Pick Color  to select a color 
from the background picture.

Select the colors for a Pattern Fill  in the Pattern tab of the ribbon bar. 

Use Backstitch Outline  to draw shapes with a freehand backstitch outline, or Cross 
Outline  to draw hollow shapes as an outline of crosses. Use No Outline  to create a 
fill area with no outline. Click the Outline color thread sample and choose a color from the 
pop-up palette.

Use Smooth to smooth the outline around shapes.

Draw a House with Stitches
1 Open PREMIER+™ 2 Cross Stitcher  and in the Start Page of the Cross Stitch Design Wizard select 

Load Picture for New Cross Stitch Design, then click Next. In the Choose Picture page, click Load a 
Picture  and load Documents\Premier+2\Samples\Cross\Pics\Small House.jpg., then click Next 
twice. In the Design Size page ensure the Cross Size is set to 2.0mm, and the Width and Height are set 
to 40 crosses. Then click Finish to display the house in the design area.

2 In the Home tab, click Design Properties and in the Design Properties dialog box ensure that Thread 
Count for Crosses and Backstitch are set to Single (2 Threads). Click OK.

3 On the View tab, ensure the Grid Size is set to 5 lines .
4 Click the Create tab. 
5 In the Shape section, ensure that No Fill  is selected (the icon to the left in the Fill area).
6 Click to select the Backstitch Outline  option (the 

middle icon in the Outline area).
7 Click the thread color for Outline, and in the pop-up 

palette click Add Color  . The Color Selection dialog 
box appears. 

8 In the Thread Range drop-down list, select Sulky Rayon 40.
Choose from any of the manufacturer’s thread ranges or one of the MyThreads ranges you created 
using PREMIER+™ 2 Thread Cache.

9 Enter 1005 in the Find Thread box, and the list will highlight Sulky Rayon 40 1005 (Black). Click OK.
The Outline thread is now black.

10 In the Shape drop-down menu, ensure that Rectangle (shape 1) is selected.
11 Click Place Shape . A rectangular shape is placed in the center of the design area.
12 Click and drag the corners of the shape so that the rectangle fits just inside the outline of the front of 

the house. The rectangle should be 24 grid squares wide by 11 high.
This is from about 10 squares in and 15 squares down from the top left of the design area, at the top left of 
the front of the house.

13 Right-click to place the shape.
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14 In the Fill section, select Cross Fill .
15 Click the thread color for Fill, and in the pop-up palette click Add Color  . The Color Selection dialog 

box appears. 
16 Enter 1246 in the Find Thread box, and the list will highlight Sulky Rayon 40 1246 (Orange Flame). 

Click OK.

A red Cross Fill  and black Backstitch Outline  are now selected, and the Shape is set to rectangle.
17 Click Place Shape . A rectangular shape is placed in the center of the design area.
18 Click and drag the corners of the shape so that 

it forms a rectangle six grid squares wide by 
nine grid squares high to create a door.

19 Right-click to place the shape.
20 At the left of the ribbon bar, click the thread 

color for Crosses, and in the pop-up palette 
select the black color.
This is Sulky Rayon 40 1005 (Black) that you 
selected earlier.

21 Click Full Cross .
22 Draw a roof gutter across the top of the wall, 

one grid square deep and one grid square wider than the wall on each side of the house.
23 Click the Standard Backstitch icon . This draws backstitch lines on the sides and diagonals of grid 

squares.
24 Now draw the roof. At the left hand end of 

the roof gutter, click and drag from one 
square in from the end (1), to place a line of 
five diagonal sections of standard 
backstitch up and to the right, then release 
the mouse button or lift the pen (2).
If you prefer, you can place each section of 
standard backstitch with a single click. Right-click is set to Erase, so you can use single right-clicks to erase 
individual sections of standard backstitch.

25 At the right hand end of the roof gutter, click and drag from one square in from the end (3), to place a 
line of five diagonal sections of standard backstitch up and to the left (4).

26 Click and drag along the grid line to place a line of backstitch along the top of the roof (2 to 4).
27 Now draw the chimney. At the top right of the roof, start two grid squares in from the end. Click and 

drag to place a line three squares straight up, then a second line three squares left, then a third line 
three grid squares back down to the roof.

28 Click Zoom To Rectangle  and the arrow pointer changes to the zoom in pointer .
29 Click and drag around the left half of the house, then release the mouse button to zoom in.
30 In the Shape section of the Create tab, click No Fill .
31 Ensure that Backstitch Outline  is selected.
32 Click the Smooth option so it is checked.

Use Smooth to smooth the outline around shapes.
33 In the Shape drop-down menu, select the Circle (shape 2).
34 Click Place Shape . A circle is placed in the center of the design area.
35 Drag the circle over the window of the house, then hold down the Ctrl key 

and move the handles on the box so they lie along the grid lines framing 
the window. Holding Ctrl resizes proportionally.

36 Right-click to place the shape.
If the window does not match the picture, click Undo and try again.

37 Look at the Design Panel. The Color Select area contains threads that are 
currently available for use in a design.
Colors can be added individually and then used, or added automatically when 
designs, shapes or lettering are inserted using thread colors that are not 
already in the palette. When the pointer is positioned over a color in this area, a 
tooltip shows the full thread color name.
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38 At the left of the ribbon bar, click the thread color for Crosses, and in the pop-up palette click Add 
Color  . The Color Selection dialog box appears. 

39 Ensure the thread range is set to Sulky Rayon 40, and enter 1030 in the Find Thread box. The list will 
jump to Sulky Rayon 40 1030 (Periwinkle). Click OK. The color is added to the Color Select area and set 
as the drawing color in the ribbon bar.

40 Click the Cross Flood Fill icon  and the pointer changes to the paint bucket .
41 Click inside the window and it will fill with pale blue crosses.
42 At the left of the ribbon bar click the thread color for Crosses, and in the palette select the black color.
43 Click the Freehand Backstitch icon .

Use Freehand Backstitch to add backstitch lines of any length to a design. Freehand Backstitch snaps to 
half-grid spacing. By contrast, Standard Backstitch only places fixed length lines that snap to the sides and 
diagonals of grid squares.

44 Click and drag a line across the middle of the window, then another line down the middle of the 
window.

45 Click the Home tab. Click Box Select .
46 Click and drag a square around the window.
47 Click the Copy icon . Click Zoom To Fit . Click Paste . A new copy 

of the window will appear at the top left.
48 Click and drag the window to the right-hand side of the house in a similar 

position to the window on the left.
49 Click the Create tab.
50 At the left of the ribbon bar, click the thread color for Crosses, and in the 

pop-up palette click Add Color  . The Color Selection dialog box 
appears. 

51 Enter 1066 in the Find Thread box, Sulky Rayon 40 1066 Primrose is selected. Click OK.
52 Click the Cross Flood Fill icon  and the pointer changes to the paint bucket .
53 Click the front wall of the house.
54 At the left of the ribbon bar, click the thread color for Crosses, and in the palette select the red color.
55 Click on the main part of the roof and the chimney.

Notice that you can change the fill color while you still 
have the Cross Flood Fill tool active.
if the whole picture fills with crosses, click Undo and 
check the backstitch outline of the roof for gaps.

56 Click the thread color for Crosses, and in the pop-up 
palette select the black color (Sulky Rayon 40 1005 
Black).
Click the Full Cross icon .

57 Click and drag under the door to place a row of six 
black crosses as a doorstep. (Alternatively, click six 
times to place individual crosses.)

58 Click the French Knot icon .
59 Click one square in from the left edge of the door 

and four squares up to place a door handle.
60 In the Shape section, select Cross Fill  and select No Outline .
61 Click the thread color for Fill, and in the pop-up palette click Add Color  . The Color Selection dialog 

box appears. 
62 Enter 1011 in the Find Thread box, and the list highlights Sulky Rayon 40 1011 (Steel Gray). Click OK.
63 In the Shape drop-down menu, select the Rectangle (shape 1).
64 Click Place Shape . A rectangular shape is placed in the center of the design area.
65 Click and drag the corners of the shape so that the rectangle is placed under the doorstep, making a 

short path that is six crosses wide and three crosses high.
66 Click the thread color for Fill, and in the pop-up palette click Add Color  .
67 In the Color Selection dialog box, enter 1100 in the Find Thread box to select Lt. Grass Green from 

Sulky Rayon 40. Click OK.
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68 Place a rectangle of crosses that is 11 wide by four high on the left of the doorstep and path. It should 
be two squares wider than the house.

69 Click Zoom To Rectangle  and the arrow pointer changes to the zoom in pointer .
70 Click and drag around the grass rectangle.
71 At the left of the ribbon bar click the thread color for Crosses, and in the palette click Add Color  .
72 In the Color Selection dialog box, select Sulky Rayon 40 1187 (Mimosa Yellow). Click OK.
73 Click the French Knot icon .
74 Start two squares in and two squares down from the top left of the grass, and click in the center of the 

grid square to place the first yellow flower head. Move right and place four more flower heads in the 
center of alternate grid squares.

75 Click the thread color for Crosses, and in the pop-up 
palette click Add Color  .

76 In the Color Selection dialog box, Select Sulky Rayon 40 
569 (Garden Green). Click OK.

77 Click the Freehand Backstitch icon .
78 Start from the center of a grid square containing a yellow 

flower head and click and drag to draw a backstitch line 
two grid squares straight down. This is the stem for the 
flower. Repeat this for the other four flowers.

79 Click the Home tab. Click Box Select .
80 Click and drag a selection box around the 

grass and flowers.
81 Click Copy . Click Zoom To Fit . Click 

Paste  and the grass rectangle with 
flowers will appear in the top-left corner. 
Click and drag the pasted grass to the right-
hand side of the path.

Use File, Save As to save the design as Small House.krz, and use Export  to export the design as Small 
House_Exported.vp4.

Using Patterns

The Pattern section of the Pattern tab on the ribbon bar is used to choose a fill pattern. 
First select a Category, then click a pattern in the gallery. When a fill pattern is selected, it is 
used for Pattern Flood Fill  and in place of crosses inside shapes and TrueType® text.

You can also design your own fill patterns (see the PREMIER+™ 2 Cross Stitcher Reference 
Guide or online help for full details on creating patterns).

Choose a Pattern Category

Click a sample to select a pattern

Change the thread colors for the pattern Preview the pattern

Create a new pattern



PREMIER+™ 2 Cross Stitcher   Creating Text               71

13Creating Text
Use the Letter tab to add text and monograms to your design. You can switch freely 
between TrueType® and Fixed fonts until your text has the desired appearance.

TrueType Font
Select TrueType Font on the Letter tab to convert TrueType® or OpenType® characters to 
crosses, crosses with backstitch outlines or a backstitch outline only. If a fill pattern is 
selected, it will be used in place of crosses when the text is applied.

Create TrueType Text
1 Click the Letter tab on the ribbon bar.
2 On the left of the Letter tab, click TrueType Font.
3 Enter the desired text in the Letters box. Press Enter for extra lines of text.
4 Click the drop-down arrow for Font and choose the desired TrueType® font.
5 Choose the desired text Style from the drop-down menu. The text style is Regular if no other style is 

selected.
6 If there is more than one line of text, choose Left , Center  or Right  Alignment.
7 Adjust the Size as desired. It is recommended to use a minimum Size of 12. The maximum is 200.
8 In Fill type, select Cross Fill , Pattern Fill  or No Fill .
9 In Outline type, select Backstitch Outline  or No Outline .
10 To select a fill pattern, click the Pattern tab, choose any available fill pattern, then click the Letter tab.
11 If desired, click the Smooth option so it is selected, to smooth the edges of characters.

Smooth uses three-quarter crosses rather than full crosses to smooth the edges. It is recommended to only 
use this for large characters.

12 If you have selected Cross Fill, click the Cross color and Color Selection dialog box appears. Choose a 
new cross color for the body of the text and click OK.

13 If you have selected Backstitch Outline, click the Outline color and the Color Selection dialog box 
appears. Choose a new color for the standard backstitch outline around the characters and click OK.
If colors are used that are not in the palette, they are automatically added to the palette when the text is 
fixed in the design.

14 Click Apply. The text will appear on the design in a selection box, and Box Select is automatically 
activated.

15 Click and drag inside the selection box to move the text to the desired position.
16 If desired, change the text or any text options (including fill pattern) and click Apply again to change 

the text before it is fixed in place.
17 Click outside the selection box to set the text in place.

You must do this for each section of text if you are placing several sections of text.

Set Fixed Font or TrueType Font

Choose a TrueType Font, Style and Size

Enter text for your lettering

Set the text alignment

Choose a cross or pattern fill & color

Place the lettering in the work area
Set outline type and color
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Fixed Font
Select Fixed Font on the Letter tab of the ribbon bar to place text using pre-defined fonts. 
Fixed Text is applied according to the design of the characters, which can include any type 
of stitch.

Create Fixed Text Lettering
1 Click the Letter tab in the ribbon bar.
2 On the left of the Letter tab, click Fixed Font.
3 Enter the desired text in the Letters box. Press Enter for extra lines of text.
4 To choose a font, click the drop-down arrow to the right of the font display and select a category and 

font from the gallery.
5 If there is more than one line of text, choose Left , Center  or Right  Alignment.
6 To use colors different from the default colors, click a thread sample in Fixed Font Colors, and the 

Color Selection dialog box appears. Choose a new color and click OK.
If colors are used that are not in the palette, they are automatically added to the palette when the text is 
fixed in the design.

7 Click Apply. The text will appear on the design in a selection box.
8 Click and drag inside the selection box to move the text to the desired position.
9 If desired, change the text or any text options and click Apply again to create a new version of the 

text.
10 Click outside the selection box to set the text in place.

You must do this for each section of text if you are placing several sections of text.
Fill patterns are not used by Fixed Fonts when the text is applied. However, the characters may be flood 

filled with any pattern using Pattern Flood Fill  after they have been fixed in place.

Create Text for the Happy House Sampler
1 In the Home tab, click Design Properties and in the Design Properties dialog box, ensure that Thread 

Count, Crosses and Thread Count, Backstitch are set to Single (2 Threads). Click OK.
2 In the View tab, ensure that Grid is set to Every 10 

Lines .
3 In the File menu, click New  or Open  and 

load 
Documents\Premier+2\Samples\Cross\Krz\Line of 
buds for Happy House.krz.
Alternatively, set up the work area and create the line 
of buds as described in “Place a Border of Buds for the 
Happy House Sampler” on page 24.

4 Click the Letter tab.
5 At the left end of the Letter tab, click Fixed Font.
6 In the Fixed Font area, click the drop-down arrow 

to view the font gallery.
7 Click and drag the scroll bar on the right of the box 

down to the Modern font category.
The Fixed Font names include the type of stitches in the font, and the number at the end is the height in 
grid squares of the 'A' character in the font. 

Use a Fixed Font or TrueType Font

Choose a Fixed Font from the gallery

Enter text for your lettering

Set the text alignment

Choose your lettering colors

Place the lettering in the work area
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Additionally, fonts that use more than one color will have 2C (two color) or 3C (three color) in the name.
8 Click the font 'Sans Cross Narrow 7'. The gallery closes.
9 Click in the Letters box and type 'Welcome To Our'.
10 Click Apply. The text will appear on the design and it is automatically selected with Box Select.
11 Click and drag the selection so that the text is centered under the top border of buds, and so that the 

tops of the uppercase letters are two grid squares from the buds. The selection box will overlap the 
buds, but the buds will not be affected.

12 Click outside the selection box to deselect the text and set it in place.

13 In the drop-down list of fonts, select 'Sans Cross 9'.
14 In the Letters box, delete the previous text, type 'Happy', press Enter, then type 'House' so that the text 

is on two lines. 
15 In the Fixed Font Colors box, click the blue color block and the Color Selection dialog box appears.
16 Ensure that Robison-Anton Rayon 40 is selected as the Thread Range. In the Find Thread text box, 

enter 2378 and the list will jump to 2378 (Red). Click OK and the color block will change to red.
The changes the color of the lettering from the blue used by the font to red.

17 Click Apply and the text will appear 
on the design, and it is automatically 
selected with Box Select.

18 Click and drag the selection to 
position the text centrally, with a 
gap of two grid squares under the 
'Welcome To Our' line. Click outside 
the selection box to set the text in 
place.

19 The Box Select  function is still 
selected, so click and drag a 
selection box around the word 
'House'.

20 Move the word 'House' exactly four 
squares up from its current position, 
so that the top of the 'H' is only one 
square below the 'y' of 'Happy'.

21 Click outside the text to deselect it and set it in place.
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14Editing Designs

Edit Crosses, Backstitch and French Knots
Draw Color and Erase
Choose a thread color from the pop-up palette in the Create tab to select a drawing color. 
Click the Erase  icon to erase stitches when drawing, or right-click while drawing with a 
color to erase stitches.

Edit Crosses
Use any type of cross to replace and erase any other type of cross. When drawing full 
crosses, they will replace or erase any combination of small or part crosses in a grid square. 
When drawing any other size of cross, they will replace or erase according to their size and 
shape. Crosses can be drawn, replaced and erased by single clicks or click and drag.

Edit Backstitch
Standard and freehand backstitch are edited separately.

Standard backstitch replaces existing standard backstitch if it is drawn in the same place. 
Standard backstitch can be drawn, replaced and erased by single clicks or click and drag.

Freehand backstitch will only replace existing freehand backstitch if it is drawn with 
exactly the same end points. If either end point is different, a new line of freehand 
backstitch is added. Freehand backstitch is drawn and replaced one line at a time with 
click and drag, and erased one line at a time with single clicks.

Edit French Knots
French knots are drawn, replaced and erased individually with single clicks. Only one 
French knot can exist at each half grid point.

Select
The select functions in the Home tab allow you to select an area of stitches. A selection 
can be rotated in 90 degree steps, mirrored, moved, copied, cut and duplicated.

The select functions may not be used to make new selections when the Multiply function is active.***
When stitches have been selected, they have a selection box around them on the design 
area. Click and drag inside the selection box to move it.

When making a selection, only stitches that are on grid points that are completely enclosed by the 
selection line will be included in the selection.

Inserting or Pasting a Selection
When a new selection is added to a design by paste, insert or the Letter functions, it is 
automatically selected and Box Select is activated. The selection is placed in the top left 
corner of the visible design area.
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Deselecting a Selection
Click the work area outside a block to deselect it. The selection box around the block will 
disappear and the selection will become part of the design. Any colors in the selection 
that were not in the palette will be added to the palette.

Selections are also automatically deselected when any new selection is added to the 
design, or when other functions that affect the design are activated.

Box Select
Use Box Select  to select crosses and backstitch in a rectangular area. Click Box Select 
and the pointer changes to the box select pointer . Click and drag around the area you 
want to select. Only stitches that are on grid points that are completely enclosed by the 
selection line will be selected. When you release the mouse button, the block will show 
you the extent of the selection. Click outside the block to make a new selection using this 
method.

Freehand Select
Use Freehand Select  to select a block of stitches within an area of any shape. Click 
Freehand Select and the pointer changes to the freehand select pointer . Click and drag 
to draw an irregular outline around the desired area. When you release the mouse the area 
is closed automatically with a straight line between the last mouse position and the start 
position. The block will show you the extent of your selection. Right-click to deselect.

Freehand Point Select
Use Freehand Point Select  to select a block of stitches within an area of any shape 
made of straight and curved lines. Click Freehand Point Select and the pointer changes to 
the Freehand point select pointer . Click a series of points to create an irregular outline 
of straight and curved lines around the desired area, using Ctrl+click to place a square 
(straight line) point. Click and drag  to reposition an existing point. Click Delete to 
remove the last–placed point. Right-click when the area is complete. The block will show 
you the extent of your selection. Only stitches that are on grid points that are completely 
enclosed by the selection line will be selected. Freehand Point Select may be easier to use 
than Freehand Select for precise selections. Right-click to deselect.

Select All Visible
Use Select All Visible  to select the whole design automatically with Box Select. The 
selection box will be shown around the edge of the design. Click outside the box, in the 
work area outside the design, to deselect.

Select None
Use Select None  to deselect all of the stitches in the design area.

Modify a Selection
Mirror the selected block of stitches vertically or horizontally using the flip handles on the 
selection box. 
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Move the pointer over one of the handles and it becomes a double-arrow pointer. Click 
the Flip handle to mirror the block horizontally or vertically.

Use Rotate 90  to rotate a selection in 90 degree steps.

When a selection is rotated, the size of the selection box may change. This helps to show the position the 
selection will take each time it is rotated.

Copy Embroidery
Click Copy Embroidery  to place the selected stitches as a cross stitch embroidery on 
the clipboard. You can then paste this embroidery into another PREMIER+™ 2 Embroidery 
System module.

Flip Vertical Handle

Flip Horizontal handle
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